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1 Introduction 

1.1 About this Manual 

This manual comprises all important information about the installation and operation of the stimulus 
generator STG4000 series and MC_Stimulus II software. It is assumed that you have already a basic 
understanding of technical and software terms. No special skills are required to read this manual. 

This documentation refers only to the STG hardware and MC_Stimulus II software. For more information 
on the STG's DLL functions and programming of custom programs, please read the separate 
documentation in the Documentation folder in the MC_Stimulus II program directory. 

If you are using the STG for the first time, please read the important safety advice before installing  
the hardware and software (see Important Safety Advice, where you will find important information 
about the installation and first steps). 

The printed manual and Help are basically the same, so it is up to you which one you will use. The help 
offers you the advantage of scrolling through the text in a non-linear fashion, picking up all information 
you need, especially if you use the Index and the Search function. If you are going to read larger text 
passages, however, you may prefer the printed manual. 

The device and the software are part of an ongoing developmental process. Please understand that the 
provided documentation is not always up to date. Check also the MCS web site from time to time for 
downloading up-to-date manuals and new software versions. 

www.multichannelsystems.com 

 

1.2 Terms of Use for MC_Stimulus II 

You are free to use MC_Stimulus II for its intended purpose. You agree that you will not decompile,  
reverse engineer, or otherwise attempt to discover the source code of the software.  

 

1.3 Limitation of Liability 

Multi Channel Systems MCS GmbH makes no guarantee as to the accuracy of any and all tests and data 
generated by the use the MC_Stimulus II software. It is up to the user to use good laboratory practice to 
establish the validity of his findings. 

To the maximum extent permitted by applicable law, in no event shall Multi Channel Systems MCS GmbH 
or its suppliers be liable for any special, incidental, indirect, or consequential damages whatever (including, 
without limitation, injuries, damages for data loss, loss of business profits, business interruption, loss of 
business information, or any other pecuniary loss) arising out of the use of or inability to use. MC_Stimulus 
II or the provision of or failure to provide Support Services, even if Multi Channel Systems MCS GmbH has 
been advised of the possibility of such damages. 
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2 Important Information and Instructions 

2.1 Operator's Obligations 

The operator is obliged to allow only persons to work on the device, who 

 are familiar with the safety at work and accident prevention regulations and have been instructed how  
to use the device; 

 are professionally qualified or have specialist knowledge and training and have received instruction in the 
use of the device; 

 have read and understood the chapter on safety and the warning instructions in this manual and confirmed 
this with their signature. 

It must be monitored at regular intervals that the operating personnel are working safely. 

Personnel still undergoing training may only work on the device under the supervision of an experienced 
person. 

2.2 Guarantee and Liability 

The General conditions of sale and delivery of Multi Channel Systems MCS GmbH always apply.  
The operator will receive these no later than on conclusion of the contract. 

Multi Channel Systems MCS GmbH makes no guarantee as to the accuracy of any and all tests and data 
generated by the use of the device or the software. It is up to the user to use good laboratory practice to 
establish the validity of his findings. 

Guarantee and liability claims in the event of injury or material damage are excluded when they are the 
result of one of the following. 

 Improper use of the device. 

 Improper installation, commissioning, operation or maintenance of the device. 

 Operating the device when the safety and protective devices are defective and/or inoperable. 

 Non-observance of the instructions in the manual with regard to transport, storage, installation, 
commissioning, operation or maintenance of the device. 

 Unauthorized structural alterations to the device. 

 Unauthorized modifications to the system settings. 

 Inadequate monitoring of device components subject to wear. 

 Improperly executed and unauthorized repairs. 

 Unauthorized opening of the device or its components. 

 Catastrophic events due to the effect of foreign bodies or acts of God. 
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2.3 Important Safety Advice 

 

Warning: Make sure to read the following advice prior to install or to use the device and the software.  
If you do not fulfill all requirements stated below, this may lead to malfunctions or breakage of 
connected hardware, or even fatal injuries. 

 

Warning: Obey always the rules of local regulations and laws. Only qualified personnel should be 
allowed to perform laboratory work. Work according to good laboratory practice to obtain best results 
and to minimize risks. 

The product has been built to the state of the art and in accordance with recognized safety engineering 
rules. The device may only 

 be used for its intended purpose; 

 be used when in a perfect condition. 

 Improper use could lead to serious, even fatal injuries to the user or third parties and damage  
to the device itself or other material damage. 

 

Warning: The device and the software are not intended for medical uses and must not  
be used on humans. 

Malfunctions which could impair safety should be rectified immediately. 

High Voltage 

Electrical cords must be properly laid and installed. The length and quality of the cords must  
be in accordance with local provisions. 

Only qualified technicians may work on the electrical system. It is essential that the accident prevention 
regulations and those of the employers' liability associations are observed. 

 Each time before starting up, make sure that the mains supply agrees with the specifications  
of the product. 

 Check the power cord for damage each time the site is changed. Damaged power cords should  
be replaced immediately and may never be reused. 

 Check the leads for damage. Damaged leads should be replaced immediately and may never be reused. 

 Do not try to insert anything sharp or metallic into the vents or the case. 

 Liquids may cause short circuits or other damage. Keep the device and the power cords always dry.  
Do not handle it with wet hands. 

Requirements for the installation 

 Make sure that the device is not exposed to direct sunlight. Do not place anything on top of the device,  
and do not place it on top of another heat producing device. Otherwise, the device may overheat. 
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3 First Use of the Stimulus Generator 

3.1 Welcome to the STG and MC_Stimulus 

Product line overview 

Stimulus generators of the 4000 series are general purpose stimulators designed for a wide variety  
of applications, both in vitro and in vivo. 

Flexible and easy-to-use MC_Stimulus software enables complex stimulus waveforms (both current  
and voltage). Waveforms designed in the program or imported from an external ASCII file are converted 
by the connected STGs into pulses, which are sent to stimulating electrodes. Stimulus isolation units (SIU) 
for each channel are included. Thus, no external SIUs are required. 

A trigger input and output for TTL signals allows to synchronize the stimulus generator with other 
instruments. Triggering of other devices via programmable TTL pulses (Sync Out) is possible, as well as 
triggering of the STG by external devices via the Trigger In input. For example, you can synchronize 
stimulation and recording with a TTL signal sent from the Sync Out output of the STG to the data 
acquisition system, for example, the MC_Card. 

Stimulus generators are available with two, four or eight completely independent stimulation channels 
(STG4002, STG4004, STG4008). Each channel is freely programmable, combination of channels to achieve 
complex stimulation patterns is not necessary. 
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4000 Series 

 

The real-time stimulus generator of the 4000 series is an advanced version and the world's first STG that  
is able to send continuous pulse streams to stimulating electrodes. In addition, you can trigger all (up to 8) 
channels separately by external TTL pulses. 2 trigger inputs (Trigger In) and 2 trigger outputs (Sync Out) 
are shared by 2 channels in the 2-channel version. 4 trigger inputs (Trigger In) and 4 trigger outputs (Sync 
Out) are shared by 4 channels in the 4-channel version, and 8 trigger inputs (Trigger In) and 8 trigger 
outputs (Sync Out) are shared by 8 channels in the 8-channel version. 

The STG 4000 series has two operating modes: Download mode and Streaming mode. 

In Download mode, you can control the STG either by the MC_Stimulus II or by a custom program. 
Stimulus protocols are created in MC_Stimulus II or the custom program; complete protocols are 
downloaded onto the STG, and can after the download be executed without a computer connection. 
MC_Stimulus II is downward compatible to MC_Stimulus (for controlling the 1000 series), that means, 
you can load stimulus protocols generated by MC_Stimulus into MC_Stimulus II, but not the other way 
round. 

In the Streaming mode, you can control the STG either by the Stimulus Streamer or by a custom 
program. If you use the Stimulus Streamer, you can load stimulus protocols in Mono-MP3 or binary file 
format of unlimited size that were generated by a custom application and are then sent continuously from 
the computer to the STG in small data packets. If you use a custom program for controlling the STG, this 
program can generate and send the stimulation protocols in parallel from the computer to the STG. 

Custom applications for the Download or the Streaming mode can be programmed in Matlab, Labview, 
C/C++, and Visual Basic. This documentation refers only to the STG hardware and MC_Stimulus II 
software. For more information on the STG's DLL functions and programming of custom software, please 
read the separate documentation of the Documentation folder in the MC_Stimulus II program directory. 
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MC_Stimulus II 

Stimuli are created user-friendly by entering the desired pulses (rectangular, ramp, or sine waveforms) 
into a worksheet. Waveforms can be combined freely to create virtually any  
stimulus pattern. 

Created stimuli are displayed in a WYSIWYG stimulus display. All channels are set up separately. 

For even more convenience, repetitive stimulus patterns do not have to be entered separately, but can be 
grouped and looped. You can also import waveforms in ASCII file format and use them for stimulation. 
You can print and save stimuli and comments for later use and documentation of your experiments. 

 

 



Stimulus Generator 4000 Series Manual 

8 

3.2 Setting Up and Connecting the STG 

Note: You can use a USB hub for connecting the STG to the computer, for example, if you have  
no free USB port or if you need to extend the USB cable. Do not use a hub in Streaming mode! Please note 
that if you want to use the STG in Streaming mode, you cannot connect a second device that sends or 
receives continuous data streams, for example a web cam or USB speakers, to the same USB port, because 
the STG needs a broad bandwidth for the data transmission. This does not matter if you want to use the 
Download mode (via MC_Stimulus II or custom program) only. 

Provide a power supply and a computer with USB port in the immediate vicinity of the installation site. 
Make sure the STG is switched off before you connect it to the power supply. 

1. Place the STG on a stable surface, where the air can circulate freely and the STG is not exposed  
to direct sunlight. 

2. Connect the external power supply to the STG. 

3. Connect the external power supply to the power outlet. 

4. Connect the USB connector to the USB port of the computer. The computer connection is necessary  
for programming the STG, but not for operating it (except in Batch mode). 

5. Connect the + and - plugs of the required output channels with 2 mm plug cables to the stimulating 
electrodes. Connect the appropriate ground to the ground input of the stimulation setup, for example,  
to the ground input of the MEA1060 amplifier. Current and voltage driven stimulation is generated from 
the same outputs. 

6. (Optional) Connect the required Trigger In inputs with BNC cables to instruments that produce TTL signals 
for triggering the STG. 

7. (Optional) Connect the required Sync Out outputs with BNC cables to following instruments that you want 
to be triggered by TTL signals from the STG, for example to one of the 16 digital inputs of the MC_Card. 

8. Switch the STG on by pressing the toggle switch on the rear panel. 

Note: It is recommended to start the STG ten minutes before use to allow warming up! 
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Illustration of the STG 4000 series front and rear panel with connectors 

STG 4004 Front Panel 

 

STG 4004 Rear Panel 

 

STG 4008 Front Panel 

 

STG 4008 Rear Panel 

 

 

3.3 Driver Installation 

The stimulus generator is a plug and play device. The driver is automatically installed together with the 
MC_Stimulus II program. 

The Windows operating system detects a new hardware when the stimulus generator is connected  
to the computer, if the program has not been installed beforehand. Simply cancel the driver installation  
and proceed with the installation of the MC_Stimulus II program. 

Important: Please make sure that you have full control over your computer as an administrator. 
Otherwise, it is possible that the installed hardware does not work properly. 

If there are any problems, and you need to install or update the driver manually, please see  
the MC_Stimulus II help for more information. 
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3.4 Installing the Software 

System requirements 

Software: One of the following Microsoft Windows ® operating systems is required: Windows 10, 8  
and 7, (32 or 64 Bit), Vista or Windows XP (English and German versions supported).  

Hardware: USB port (2.0 High Speed) 

 

Installing the software 

Please check the system requirements before you install the software. MCS cannot guarantee that the 
software works properly if these requirements are not fulfilled. 

Important: Please make sure that you have full control over your computer as an administrator. 
Otherwise, is possible that the installed software does not work properly. 

1. Double-click Setup.exe on the installation volume. The installation assistant will show up and guide you 
through the installation procedure. 

2. Follow the instructions of the installation assistant. Please select the appropriate maximum number of 
analog output channels according to the connected STG. If you have different STGs in use, choose the 
highest number.  
 
For the devices with internal stimulation, STG3008-FA and MEA32-STIM4 separate manuals are available. 

 

When you have finished the installation of the MC_Stimulus II software and the STG driver,  
you can now operate the STG. 
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4 Operating the STG 

4.1 Operation Overview 

 

Warning: Make sure that you do not come in contact with the cables or the connectors  
of the STG after you have started the STG. The high voltage and power can lead  
to injuries. 

 

Warning: Do not start the STG if you are unsure about the channel configuration  
or the nature of the downloaded file. 

1. Set up your experiment. 

2. Switch the STG on. 

Note: It is recommended to start the STG ten minutes before use to allow warming up! 

1. Set up your stimuli with the MC_Stimulus II program. 

2. Send the stimulus sequence from a MC_Stimulus II file to the STG. 

3. Start the STG either manually by pressing the Start / Stop button on the front panel, with the software 
controls, or with an external trigger. 

Creating stimuli 

Stimuli are created user-friendly by entering the desired pulses (rectangular, ramp, or sine waveforms)  
into a MC_Stimulus worksheet. Waveforms can be combined freely to create virtually any stimulus pattern. 
Created stimuli are displayed in a WYSIWYG window. 

Starting stimulation 

Note: You need a computer connection only when you are using the software controls for starting and 
stopping the stimulus generator. When you are using the STG interface or an external control (trigger, you 
can disconnect the stimulus generator from the computer and operate it independently. But you cannot 
remove the STG from the power connection. The memory is cleared when the STG has lost power. 

After the download of the stimulus file on the STG, you can start the stimulation. There are several ways  
to start the STG. 

MC_Stimulus 
II interface: 

You can start the stimulation directly after the download (with the command 

Download and Start  or also later with the command Start . You can stop 

stimulation with the command Stop . Starting the STG by using the Start command 
is considered as activating all trigger inputs, that is, all channels are started, and all Sync 
Out outputs are active. Likewise, all channels are stopped when you click Stop. 

You can start the stimulation after download   on up to eight trigger separately. 

Please use the combined LED / Start / Stop buttons . 
You can start and stop the stimulation manual whenever you want by clicking the 
corresponding LED / Start / Stop button. The LED indicates the status: Black means 
trigger off, red means trigger on. The first button on the left side belongs to trigger 1, 
the second button to trigger 2, and so on.  
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STG 
interface: 

You can start the stimulation by pressing the Start / Stop button on the front panel of 
the STG. Press the button again to stop the stimulation. Starting the STG by pressing the 
Start / Stop button is considered as activating all four trigger inputs, that is, all 
channels are started and stopped, and all four Sync Out outputs are active when the 
STG is started. Pressing the Start / Stop button stops the stimulation if at least one 
channel is still active in the moment of the trigger event (indicated by the lighting SWEEP 
LED). Pressing the button starts stimulation only if no channel is active (dark SWEEP 
LED) 

 

External 
control: 

You can start the stimulation on a trigger from an external device, for example,  
a switch. You can use up to eight trigger inputs that independently trigger the analog 
output channels that you have assigned to them. The trigger works in a similar way as 
when you press the Start / Stop button. You can choose the action that will be taken 
when one of the channels that are assigned to the respective trigger input is still active. 
Either the stimulus protocols on the triggered channels are stopped or restarted; or the 
trigger event is ignored. There is also a separate Sync Out output for each Trigger In 
trigger input. You can assign the Sync Outs to the trigger inputs. The default settings 
define that Sync Out 1 is active when Trigger In 1 is triggered, and so on. Please see 
Trigger Settings for more details.  

STG status control 

Three status control LEDs (light-emitting diode) are present on the front panel  
of the STG to give you a quick overview on its status. 

POWER STG has been switched on. 

PROG Stimulus file was downloaded to STG. STG is now ready for operation. 

SWEEP Stimulation is running, that is, at least one output channel is active. 

MC_Stimulus II status control 

The top part of the MC_Stimulus II status control refers to the active instance of the MC_Stimulus II 
program instance and the STG that is controlled by this instance. All information in this part is saved on  
the STG. The information is updated in the MC_Stimulus II main window when the connection to the STG 
is changed or interrupted. 

Status light Color Meaning 

Connected Green STG is connected and switched on. The serial number serves as an ID  
for the controlled STG and is displayed on the left. On the STG menu,  
click Select Device to select another STG connected to a different  
USB port from the drop-down list to switch STGs. 

Programmed Green Stimulus file in voltage mode has been downloaded to STG.  
STG is now ready for operation. File name and path of the *.stm file  
that was downloaded onto the STG are displayed on the right. 

Orange Stimulus file in current mode has been downloaded to STG.  
STG is now ready for operation. File name and path of the *.stm file  
that was downloaded onto the STG are displayed on the right. 

Sweep Red Indicates the active trigger (up to eight). Each stimulation channel can be 
assigned to any trigger. If all eight channels are assigned to trigger one for 
example, only one sweep indicator will light up, even though all stimulation 
channels can be active. See also Triggering Stimulation. 
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STG and Stimulus Protocol Information: 

 

 

Autocalibration 

During the first ten minutes after starting the STG, the device emits every minute high frequency signals 
(small bursts) for internal offset calibration of the current outputs in a range of +/- 10 mV. After warming 
up the STG, the calibration signals later will be delivered half-hourly. 

Note: It is recommended to start the STG ten minutes before use to allow warming up! 

High sensitive measuring equipments will monitor these calibration signals as artefacts which might disturb 
the stimulation when using very low stimulus pulses (< 100 μA) in current mode. Enable the option 
“Disable Autocalibration” in STG main menu to avoid the autocalibration. Download the command to the 
STG. 
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4.2 Operating Multiple STGs 

   

If you have more than one STG connected to the same computer, please click under "STG" in main menu 
"Select Device". In the "Select Device" dialog you can choose which STG you like to control from the 
currently active MC_Stimulus II program. 

 The serial number is printed on the STG's case. The serial number of the currently active STG is displayed 
on the status bar of the currently active instance of the MC_Stimulus II program. 

 

 Click Select Device under STG in main menu. Select the serial number of the desired STG from the STG 
list. 

 You can open multiple instances of the MC_Stimulus II program and control multiple STGs at the same 
time. Please make sure that you control each STG only by one MC_Stimulus II instance. 

 You can also open only one MC_Stimulus II instance and control multiple STGs one after the other by the 
same instance. Simply change the settings in the Select Device dialog and select the next STG when you 
have finished to program the first. The STGs can be operated without a computer connection. 
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4.2.1 Operating the USB-MEA32-STIM4-System 

The USB-MEA32-STIM4-System has an integrated four channel current stimulus generator. For operating 
this kind of STG, please select the device in Select Device dialog via serial number. To select stimulation 
channels, open the dialog Select Stimulation Channels in Edit menu. 

 

Select Layout: 1 x 12.  

It is possible to assign stimulation channel 1 and 2 to stimulation electrodes S1 to S6. It is not possible  
to select the same electrode for both channels. Stimulation electrodes S7 to S12 have to be assigned  
to channel 3 and 4. If you do not need four channels for stimulation, click check box "channel off".  

For programming the stimulation channels, please use MC_Stimulus II as usual. 
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5 Programming Stimulus Protocols 

5.1 MC_Stimulus II Sample Files for STG 4000 Series 

These sample files are intended for demonstrating basic features of the Stimulus Generator STG 4000 
series, for basic applications with the MEA-System. If you are using an MEA-System, please see also  
the MC_Rack tutorial in the MC_Rack help or the separate PDF on the installation volume. 

The sample files are automatically installed to the Examples folder in the MC_Stimulus II program 
directory. 

Please note: The demo files were kindly provided by STG users. MCS does not guarantee that these files will 
be appropriate for your application and stimulating electrode type. For using MEA electrodes as stimulating 
electrodes, MCS recommends the use of monopolar voltage pulses, though some MEA users feel that they 
have better results with bipolar voltage pulses, depending on the cell culture or tissue used. 

 

Warning: Always obey the recommendations of the stimulating electrode manufacturer. 

 

5.2 Neuroelectrophysiology / MEA-System 

LTP-Induction.stm 

 Stimulus type: Pulse train of 100 biphasic pulses for LTP induction  
 Amplitude: 1.5 V  
 Duration: 100 μs per phase  
 Inter-Stimulus-Interval/Frequency: 10 ms / 100 Hz  

LTP-Testpulse.stm 

 Stimulus type: Biphasic test pulse  
 Amplitude: 1.5 V  
 Duration: 100 μs per phase  
 Inter-Stimulus-Interval: 60 s  

PairedPulse.stm 

 Stimulus type: Paired biphasic test pulse for paired pulse facilitation and depression  
 Amplitude: 2 V  
 Duration: 100 μs per phase  
 Inter-Stimulus-Interval: 20 ms between paired pulses, 10 s between pairs  

IOcurve-500-3000.stm 

 Stimulus type: Voltage step series with biphasic pulses for I/O analysis  
 Amplitude: 500 mV to 3 V, increments of 250 mV, 3 repeats  
 Duration: 100 μs per phase  
 Inter-Stimulus-Interval: 10 s  



Stimulus Generator 4000 Series Manual 

18 

 

monophasic_voltage_1V_100μs.stm 

 Stimulus type: Monophasic test pulse  
 Amplitude: 1 V  
 Duration: 100 μs  
 Inter-Stimulus-Interval: 24 ms  

biphasic_voltage_1V_100μs.stm 

 Stimulus type: Biphasic test pulse  
 Amplitude: 1 V  
 Duration: 100 μs per phase  
 Inter-Stimulus-Interval: 24 ms  

ASCII-Import-Biopotential.stm 

This file is not intended for a real experiment, but demonstrates the ASCII import feature. Shown is a single 
spike recorded from an organotypic hippocampal culture with the MEA-System. The spike waveform was 
exported as ASCII from MC_Rack and imported into the MC_Stimulus II program. The imported file is 
"ASCII_Import_Biopotential.dat". 

5.2.1 General Demo Files 

Demo_Waveforms.stm 

This file is not intended for a real experiment, but for demonstrating the capabilities of the stimulus 
generator. The file includes stimuli with increasing inter-stimulus interval and with increasing amplitude, 
ramps and sine waveforms. 
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5.3 MC_Stimulus II Worksheet 

You can freely combine any pulse types. Use a separate row for each pulse type. 

Hint: Several tools are provided for editing whole columns at once or autocreating entries. 

1. Select the desired output type first. Click either Voltage or Current under Output Mode on the file 
window of MC_Stimulus. 
 

 

2. Click a tab to select an output channel. The according channel worksheet is brought to front. 
 

 

3. Now you can enter the pulses into the worksheet. Select a Pulse type (either rectangular, ramp, or sine). 

4. Enter the desired voltage steps and a time length for each step. 
 

 
 
The according pulse is displayed in the WYSIWYG display at once. 
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5.4 Pulse Types 

Three basic pulse types are available in MC_Stimulus II. You can create virtually any pulse by combining 
different types. 

 Rectangular 

 Ramp 

 Sine wave 

Note: The time resolution is 20 μs. When you enter time steps that are not a multiple of 20 μs, the length 
of the step is internally adjusted (rounded arithmetically, that is, 249 μs would be rounded down to  
240 μs, 250 would be rounded up to 260 μs) to a valid value. The minimum voltage resolution is 1 mV,  
the current resolution is 200 nA. Please regard also the minimum and maximum output voltage / 
current of your STG version. If you enter voltage or current values outside the STG's limit, the invalid  
value will be changed automatically when you download the protocol. Cells with changed values will be 
highlighted in yellow. 

Note: If you work near the resolution limits of the STG, the output pulses may differ from the 
programmed pulses. In this case, you should check the output with an oscilloscope. Please see also  
the "Analog Output Signals" chapter. 

 

Please note that the memory of the STGs of 4000 series is limited (64 MB). You will get an error message  
if the memory is full.  

For the digital Sync channels, only TTL pulses with bit patterns of 0 (LOW) and 1 (HIGH) can be 
programmed. A logical state of 1 (HIGH) results in a 3.3 V output signal, and a logical state of 0 (LOW) 
results in a 0 V output. Please note that the digital output is sent about 20 μs faster than the analog 
output. Please see also the "Triggering Stimulation" chapter. 

Rectangular pulse type 

 

 Enter each voltage / current level and the duration of the pulse. The voltage / current jumps directly  
to the specified level. In one row, you can enter up to three voltage / current levels. Use the next row  
for programming more levels. 
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Ramp pulse type 

 

 Define the starting point, end point, and the length of the ramp. The ramp is then build according  
to these parameters in small single steps of 20 μs. 

Sine wave pulse type 

 

 Define the amplitude and the period of the sine wave. The sine wave is then computed according  
to these parameters with a minimum resolution of 1 mV and 20 μs. If you enter a negative amplitude,  
the sine wave starts with its negative alternation. 
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5.5 Autorepeating Pulses and Protocols 

 

For entering complex stimuli easier and faster, you can repeat rows and groups instead of entering the 
pulses several times into the worksheet. You can repeat each single row. In the preceding example, the 
rectangular pulse in row 1 is repeated twice. You can also group several rows and repeat them altogether. 
In the example, pulses from rows 1 to 4 are grouped and repeated three times. 

Repeating rows 

 Type the number of repeats into the Row Repeat cell of the appropriate row. The pulses of the complete 
row are repeated the specified number of times. 

Grouping and repeating groups 

1. Select several cells by clicking and dragging cells in the Group Repeat column. Selected cells are 
highlighted in black. 

2. Point to the selected cells and right-click to open the context menu. 
 

 

3. Click Group / Ungroup. The corresponding rows are grouped now. This is indicated by a merging  
of the Group Repeat cells. 
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4. Type the number of repeats into the merged Group Repeat cell. 
 

 

Repeating complete pulse protocols (autorepeat function), Continuous Mode 

You can repeat the complete stimulus on all output channels that are triggered by the same trigger. This 
means, each time when a trigger event occurs, the complete stimuli on all corresponding output channels 
are repeated for the specified number of times. If the stimuli have different lengths, the starting points are 
synchronized. For example, if channel 1 has a stimulus with a length of 500 ms, and channel 2 of 1000 
ms, and both are triggered by the same trigger event, channel 1 waits 500 ms for the repeat until the 
output stream of channel 2 has been finished. 

Note: The Sync Out signal for the corresponding trigger is repeated as well each time the stimulus is 
repeated. 

Hint: You can repeat the complete stimulus protocol that is assigned to a trigger continuously by using 
the Continuous Mode setting. Continuous mode can be activated in the main window or under Trigger 
Settings.  The STG has then to be stopped manually by the user. You can use this feature regardless 
whether you use an external trigger input or not. When you press the Start button, this is considered  
as if all four trigger inputs were active.  

When you use Continuous Mode, the repeats entered in the Trigger Settings dialog box are disabled. 

  

 

1. On the STG menu, click Trigger Settings. 

2. Enter the number of repeats for each trigger separately. 0 repeats the output signals continuously. 
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In the following example, the stimuli on output channels 1, 3, and 6 that are all triggered by Trigger 1 are 
repeated three times after the trigger event, each time accompanied by the Sync Out 1 output. All other 
stimuli are applied once after their respective trigger event. 

 

Repeating complete pulse protocols, Gating Trigger 

Repeated stimulation of complete protocols can also be controlled by a gating trigger. Channels associated 
with a Trigger input will be active as long as the condition of that Trigger is 1 (HIGH) and switched off as 
soon as the condition becomes 0 (LOW). Gating trigger function can be enabled in the Trigger Settings 
menu. 
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5.6 Autocreating Entries and Editing Columns 

Changing time units for a complete column 

1. Click any Unit column header to select a column. The selected column is highlighted in black. 

2. Right-click and click Change Time Unit. 
 

 

3. Select the desired time unit. 
 

 
 
All units in the column are set to the selected time unit. 
 

 



Stimulus Generator 4000 Series Manual 

26 

Inverting pulses in a column 

1. Click any Value column header to select a column. The selected column is highlighted in black. 

2. Right-click and click Invert Selection. 
 

 
The polarity of the signals is switched from positive to negative and vice versa. 
 

 

Incrementing columns 

This feature is very convenient for setting up long and complex stimuli without entering each value 
manually. You can enter and edit multiple voltage values or time lengths. 

You can keep all zero values unchanged with the option Keep Zero. 

Apart from an absolute shift or increment factor, you can modify values by the percentage as well. 

Shifting time or voltage / current values 

You enter a value, which is added arithmetically to all values in the selected column. For example,  
if you enter "-50", -50 is added to all values. 

1. Click any Value or Time column header to select a column. The selected column is highlighted in black. 
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2. Right-click and click Increment Selection. 
 

 

3. Under Type of Increment, select Shift. 

4. Enter the desired value. 

 

All values in the selected column are modified by the selected factor. In the example, 100 is added to all 
values, resulting in a total of 100 because the initial value has been 0. 

 



Stimulus Generator 4000 Series Manual 

28 

Creating time or voltage / current increments 

With this option, you enter a base value for modification of all values in the selected column. The first row 
is modified by the base value. The second row is modified by the double value, the third row by thrice the 
base value, and so on. With this feature, you can easily set up time or voltage increments. 

1. Under Type of Increment, select Count. 

2. Enter the desired start value. 

 

The value in the first row is incremented by the selected start value of 10. The next value is modified by the 
double value (20), and so on. 
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You can now fill further columns in the same way. Thus, you can easily set up a stimulus with incremented 
pulse lengths like this with only a few mouse-clicks. 

 

In the same way, you can set up a stimulus with voltage / current increments. 

 

Shifting absolute time or voltage values 

With this option, the signs of the selected values are ignored. Zeros are never changed, that is, the option 
Keep Zero cannot be deselected. 

1. Under Type of Increment, select Absolute Value. 

2. Enter the desired shift factor. 
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The absolute values of 200 and 200 are both 200. This absolute value of -200 is modified by the shift factor 
of 50, resulting in 250. The negative value is now 250, and the positive value is 200. (If you had chosen the 
option Shift instead, the computed result would have been 200 + 50 = 250.) All zero values are not 
changed. 

 

Autocreating entries 

You can use the Autofill feature to set up advanced time or voltage/current increments. You define the 
Start and End value and either the Step Size (Start - Stop - Step Size) or the number of Steps (Start - 
Stop - # of Steps). Alternatively, you can enter the Step Size and the Number of Steps (Start - Step 
Size - # of Steps). According to these specifications, rows are inserted and the column is filled 
automatically. 

In the following example, the Autofill feature has been used to create a voltage step series from 20 mV  
to 500 mV with an increment of 20 mV. 

1. Click any Value or Time column header to select a column. The selected column is highlighted in black. 

2. Right-click and click Autofill. 

3. Select one out of three commands and fill in the white text boxes. 
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The column is filled according to the specifications. 

 

 

5.7 Auto Sync for Autocreating Trigger Pulses 

If you want to synchronize other devices, for example, a MEA1060-BC amplifier or the MC_Card with  
the stimulus generator, you have to set up the digital output of the Sync Out channels in synchrony to the 
stimulus pulses. This may sometimes be a bit tricky and time consuming, especially for complex stimulus 
protocols. 

The Auto Sync feature is intended for making the work with MC_Stimulus more efficient: Digital Sync Out 
TTL pulses synchronous to stimulus pulses are generated automatically by this feature. Each time an analog 
channel generates a pulse (that is, its value is not equal to zero), the logical state of the assigned Sync Out 
channel is set to HIGH (=1). You can set the time offset of the TTL's rising edge before the stimulus pulse 
and of the TTL's falling edge after the pulse. If you change the stimulus protocol, corresponding Auto 
Sync pulses are updated on the fly. This feature is especially recommended for controlling the MEA1060-
BC amplifier with superior stimulus artifact suppression. 

1. On the Edit menu, click Auto Sync Settings. The Auto Sync Settings dialog box appears. 
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2. Assign the analog stimulus channels that will be used as the basis for autocreating the protocols on the 
Sync Out channels 1 to 4. For example, if you use only stimulus channel 1, select Ch1 under Sync1. If you 
use a MEA1060-BC amplifier, you can use up to two output channels per amplifier, that is, you may want 
to select Ch1 and Ch2 for Sync1. The preceding screen shot shows an advanced setup that could be used, 
for example, for a setup with 4 MEA1060-BC amplifiers, each connected with two analog STG channels 
and one Sync Out. 

3. Set the time offset of the TTL's rising edge before the stimulus pulse (Pre Time) and of the TTL's falling 
edge after the pulse (Post Time). For operating a MEA1060-BC amplifier, a Pre Time of 0 μs and a Post 
Time of 100 μs are default, but especially the Post Time may have to be adjusted according to your 
stimulus amplitude and the stimulus artifact suppression performance (please see the user manual of your 
MEA1060-BC amplifier or the MEA_Select Help for more details). 

4. On the Settings menu, click Auto Sync to enable the Auto Sync feature. The Sync Out protocols will  
be autocreated in synchrony with the pulse protocols on the assigned channels, will show up in the 
WYSIWYG window immediately, and will be downloaded onto the STG with your next download. 
(Please make sure that the display and download options are appropriate, that is, all necessary Sync Out 
channels are selected.) The worksheets of the Sync Out channels assigned to the Auto Sync feature will 
be unavailable, that is, you cannot edit them manually. The following screen shot shows an example of  
a monophasic 100 μs voltage pulse on channel 1 and the corresponding Auto Sync pulse (Pre Time 0 μs, 
Post Time 100 μs) on Sync Out 1. 
 

 

5. If you later choose to edit the Sync Out worksheets of the active file manually, you can deselect the Auto 
Sync feature on the Settings menu. Any information in the Sync Out worksheets that was there before 
the Auto Sync option was enabled will be restored; and all worksheets will be available for manual 
editing. 

5.8 Adjusting the Stimulus Intensity Level 

After having programmed the stimulus protocol, you can either download the protocol "as is", or you  
can adjust the stimulus intensity level, that is, choose a percentage (from 0 to 200 percent) of the 
programmed amplitudes, independently for each of the up to 8 channels. You can adjust the level offline 
and download the information onto the stimulus generator manually afterward, or you can adjust the 
level on-the-fly, without stopping the running stimulation. This feature is especially convenient for testing 
out thresholds that evoke a biological response. 

Note: The error messages that are displayed when the stimulus amplitude is not set to zero at the end of 
the protocol or when the time length of stimulus protocols is different on individual channels can present  
a nuisance when adjusting the level on-the-fly. These error messages can be switched off by deselecting the 
option Enable Compiler Warnings on the Settings menu. 

1. On the Edit menu, click Amplitude. The Amplitude dialog box opens. You can drag and drop  
it anywhere you like on the screen, also outside the main window of the MC_Stimulus II program.  
This is especially convenient when you are using two monitors. 

2. Select the option Auto Download if you want to adjust the stimulus intensity level on-the-fly. Deselect 
the option if you want to download the changes manually later. 
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3. Select the option Change All if you want to adjust the stimulus intensity to the same level on all channels. 
Deselect the option if you want to set individual channels to different levels. 

4. Drag the slider with the mouse for adjusting the stimulus intensity in the range of 0 to 200 percent of the 
programmed stimulus amplitudes. The WYSIWYG display is updated automatically. The worksheet is not 
updated. It always relates to the stimulus protocol that you programmed initially. If Auto Download is 
selected, changes are immediately downloaded onto the stimulator after releasing the slider, and the 
stimulus protocol is restarted from the beginning, with the adjusted stimulus intensity level. 

5. If Auto Download was not selected, you need to download the stimulus protocol manually for changes  
to take place. 

6. You can click the Reset All button to set the level on all channels back to 100 percent. 

 

 Stimulus Intensity dialog box of the 4-channel version of MC_Stimulus II 

Channel 1 is set to 100 %, that is, the stimulus protocol will be downloaded onto the stimulus generator  
as it was programmed in the worksheet. Channel 2 is set to 50 %, that is, all stimulus amplitudes 
programmed on channel 2 are halved. Channel 3 is set to 150 %, that is, all stimulus amplitudes 
programmed on channel 3 are one and a half. Stimulus amplitudes on channel 4 are doubled. 
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6 ASCII Import / Export 

6.1 Loading Files 

The ASCII import filter is used to load stimulus protocols from an ASCII file into the stimulus worksheet  
of MC_Stimulus II. You can use this feature for feeding recorded signals (for example, exported from 
MC_Rack, see the MC_Rack manual) into the stimulus generator. You can also export the data from 
MC_Stimulus, modify it with your custom text or spreadsheet editor, and reimport it into MC_Stimulus II. 

The current version of the import filter is version 3.1.2 

 

 ASCII import example: Stimulating with biopotential waveforms 

Shown is a single spike recorded from an organotypic hippocampal culture. The spike waveform was 
exported as ASCII from MC_Rack and imported into the MC_Stimulus II program.  

 

Warning: All previous records in the active MC_Stimulus II file (*.stm) file are overwritten.  
Please create a new file and import the data into an empty worksheet to avoid data loss. 

1. On the File menu, click Import ASCII File. The Open dialog box appears. 

2. Select an appropriate ASCII file and click Open. The stimuli from the ASCII file are loaded into the active 
MC_Stimulus worksheet. All previous records are overwritten. Channels that are not present in the ASCII 
file are empty. You can now edit and download the stimulus file as usual. 

If the file does not fulfill the requirements of a stimulus file, an error message will show up and tell you in 
which line the first error occurs. See "Supported File Format" for more information about supported ASCII 
files. 
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6.2 Exporting Files 

1. On the File menu, click Export ASCII File. The Save As dialog box appears. 

2. Browse to the target folder and enter a file name. 

3. Click Save to generate the ASCII file. 

All pulse protocols from the active file will be saved in ASCII file format. The MC_Stimulus II ASCII format 
type is format type 4. For your convenience, the generated ASCII file includes the header that is required 
for reimporting the file into MC_Stimulus II. 

6.3 Supported File Formats 

The ASCII text must exactly follow the specifications below. The parameters in angle brackets are 
placeholders for any valid numbers or strings. 

Hint: You can set up files conveniently in any standard spreadsheet program and save them as tab-
delimited ASCII. 

General 

 The file name and the file name extension are not important. You can use any extension you like,  
for example *.txt, or *.dat, or any other. 

 Comments are introduced by the number sign #. The rest of the line after # is only for your information;  
it is completely ignored when executing the stimulus file. (You do not need comments, of course, but it is 
convenient for documentation.) 

Hint: Use # to comment lines out. That is, you can disable lines without removing it from the file.  
Thus, you can keep the lines for later uses. 

 Blank lines are ignored. 

 The spelling is strict. The MC_Stimulus II program does not recognize a keyword if it is misspelled  
or if even only one character is missing, but it is not case-sensitive. 

 The file has the following structure. 

1. File header 

2. Data 

File header 

The first two non comment lines have to be the following lines. Files for older versions of the import filter 
(version 1.00) can be imported with the current version as well. 

Multi Channel Systems MC_Stimulus II 
ASCII import Version 1.10 
 
The next three lines have to be the following lines (in any order). 

channels: <number> 
output mode: <mode> 
format: <format number> 
 
Make sure you define the total number of channels for the used STG properly (4 channels for a STG with  
4 channels, 8 channels for a STG with 8 channels, and so on), according to the software version. You can 
select the maximum number of channels during the installation of MC_Stimulus. On the Help menu, click 
About MC_Stimulus II to check your current software version. 
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Example: 

You have to include the following line in the ASCII file if you have installed MC_Stimulus II  
for STG2004. 

channels: 4 

 
Output mode is either voltage or current. 

Example: 

output mode: voltage 

 
Six different format types are available: 1, 2, 3, 4, 5, 6. 

Example: 

format: 3 

Data 

Preceding the data, the output channel number has to be specified by the following line. 

channel: <channel number> 
 
You can specify analog output channels from 1 to 8 (limited by the number of analog output channels  
of the connected STG, of course). 

The digital Sync Out channel number directly follows the maximum number of output channels. For 
example, if you have installed MC_Stimulus II for 4 channels, the Sync Out channel is channel number 5;  
if you have installed MC_Stimulus II for 8 channels, the Sync Out channel is channel number 9. 

The data follows after the channel specification line; three format types are available. All format types 
follow the MC_Stimulus II worksheet's structure of rows and columns. See the description of the worksheet 
for more details. Columns are separated by blanks or tabs. The first line has to contain the column headers. 
The following lines contain the voltage/current and time values. Rows/lines are separated by a carriage 
return or line feed (CR / LF). This is the Windows standard control character inserted when you press the 
ENTER key. 

The voltage unit is mV and the current unit is μA. Please make sure that all values are in the ranges 
specified for the STG you use. For the Sync Out channel, only values of 0 and 1 are allowed. 

The time unit is μs. Time values can be in the range from 20 to 18.000.000.000 (20 μs to 5 h).  
Time base of the STG is 20 μs, so only times that are multiples of 20 μs are valid.  

Note: Please make sure that there are no additional tabs or characters, which would lead to an error 
message. Show tabs and spaces in your text editor and check the file before importing it. 
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Format type 1 

This is a basic format with two columns of Value and Time each, without Repeat functionality. 

value time value time    

Format type 2 

With this format, you can repeat rows in the same way as described for the worksheet.  
Group repeat is not available. 

value time value time repeat   

Format type 3 

This format type is available only in the current version of the import filter. It allows you to use  
a third column of Value and Time. 

value time value time value time repeat 

Example: 

The following picture shows an ASCII stimulus file opened in a standard spreadsheet program. 
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The same file would look like this in a standard text editor program. You can see the tabs, spaces,  
and CR / LF. 

 

After loading the file into the MC_Stimulus II worksheet, you can edit and download the file  
as usual. 
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Format type 4 

This format type is available only in the current version of the import filter. It is the plainest format with  
only one column for the voltage / current values and one column for the time lengths. This format  
is the standard format if you want to import data for example from Excel. 

This format type is generated when exporting MC_Stimulus II files as ASCII. 

value time      

Format type 5 

This format type is available only in the current version of the import filter. It allows you to use ramp and 
sine waveforms as well as rectangular waveforms. You specify the Pulse type in the first column, and the 
waveform in the three following columns. The general rules for setting up ramp and sine waveforms fully 
apply (see also Pulse Types). The pulse types are defined by the following numbers: Rectangular = 0,  
ramp = 1, sine = 2. 

You can only use the rectangular type (0) for the Sync Out channels. 

Important: When setting up rectangular or sine waveforms in this format type, you need only one value 
column for defining the amplitude, but you have to define both value columns even so. The first value 
column is ignored for rectangular and sine pulse types by the MC_Stimulus II program. 

pulse (0, 1, 2) value value time    
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Example: 

This is an ASCII file viewed in a standard text editor program. You can see the tabs, spaces,  
and CR / LF. 

For demonstration purposes, a ramp type pulse was programmed on the first channel, a sine wave on  
the second channel, a rectangular waveform on the third channel, and mixed pulse types on the fourth 
channel. 
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After loading the file into the MC_Stimulus II worksheet, you can edit and download the file  
as usual. 

 

 

Format type 6  

Note: This file format is used by MC_Rack ASCII export! 

This format type is available only in the current version of the import filter. This is a basic format with two 
columns: The absolute time in seconds, and the absolute value of voltage in microvolts (μV) or current in 
microamper (μA). This file format is used by MC_Rack ASCII export. You can directly import the MC_Rack 
export files into MC_Stimulus II.  

time value 

You can use this format with or without header. 

Example: 

The following picture shows a file of format type 6 without header. 
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The following picture shows a file of format type 6 with header. 

 

Using the format type 6 without header, only the first channel of the MC_Rack raw data file can be 
imported.  

Using the format type 6 with header you choose how many channels are imported in "channels", line 3. 
 The output mode in line 4 has to be voltage. You choose which channel should be imported first in 
"channels" line 6. You can add the channels you also want to import one after the other in any order. 

The value microvolt is normally used for data recording in voltage mode of MC_Rack. The STG generates 
voltage pulses in values of millivolt. Please use the “Amplification” factor of the ASCII Import Dialog to 
convert μV in mV, otherwise the output of the STG is zero.  

 

The amplification factor is generally applied in files with and without header. 
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ASCII Import of Files  

For ASCII import of files, please use the command ASCII Import in main menu "Settings". 

 

The dialog "ASCII Import Settings" will open. 

 

Settings for ASCII import files without header:  

Select the format type from one to six from the drop down menu "Format". 

Select the number of the row from which the file should be imported. Row numbers are available from  
one to ten from the drop down menu "From row". 

Select the "Output Mode" in the check boxes: Voltage or Current. 

Settings for ASCII import files with or without header:  

Please choose the factor of amplification in "Amplification". This is very helpful, for example, for importing 
data recorded in microvolt μV and now needed in millivolt mV. That means, the factor is 1000 or – for 
higher stimulation signals - may be 10000. Please see chapter "Format Type 6" above. 

Important: MC_Stimulus II uses the header of an ASCII import file, if a header is available. If no header  
is available, MC_Stimulus II applies the settings of the dialog "ASCII Import Setting". 
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7 Stimulus Display 

7.1 Selecting Channels 

To enlarge the display size of the channels, we suggest that you show only those channels  
you are currently working with. 

Note: This will affect only the display. It has no effect on the download of signals. To select or deselect 
channels for downloading, click the Download Channel (or Download Sync) check boxes in the main 
window of the program. 

 Clear the check box of all channels that are not in use. 

All channels that are not selected are removed from the display. 

 

7.2 Display Settings 

You can toggle between a decimal time scale in seconds (floating point numbers) and a time of day 
scale in the format hh:mm:ss:zzz, where h means hour, m is minute, s is second, and z is millisecond. 

 Under Settings, click X Axis Time Format. Select the option to enable the time of day scale. Deselect  
the option to switch to the decimal time scale. 

7.3 Display Tools 

 Several tools are provided to optimize the graphical presentation of the stimuli. If you later choose  
to display channels, the axes of the new displays are set to the default values. 

 The time axis can display only positive values. 

 The y-axis of the Sync Out channels cannot be adjusted, because only values of 0 and 1 are available  
for these channels. 
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  

 

 
Enable 
scrolling 

Scroll the axes by clicking and dragging with your mouse. 

 
Enable 
scaling 

Zoom the axes by clicking and dragging with your mouse. 

 
Zoom out Reduces the time scale. 

 
Zoom in Magnifies the time scale. 

 
Reset Resets the axes of all channels to the default values. 

 
Size to fit 
 

Adjusts the ranges to fit the largest displayed stimulus. 

 
Show 
measure 
tool 

A horizontal bar is shown that displays the current / voltage and the time  
value of the intersection point. Drag the bar with the mouse.  

Scrolling the axes 

You can scroll the stimuli forward and backward along the time axis, and up and down along  
the voltage / current axis. 

1. Click   to enable the scrolling. 

2. Click the axis you like to scroll. The mouse pointer becomes a hand. 

 

3. While holding down the mouse button, move the axis to the left and right, or up and down. 
- OR - 
You can use the keyboard: Press LEFT ARROW or DOWN ARROW to move the axis to the left (down), 
RIGHT ARROW or UP ARROW to move the axis to the right (up). 
- OR -  
Use the PAGE UP and PAGE DOWN keys for a faster scrolling (larger steps): PAGE DOWN  
to move to the left (down), PAGE UP to move to the right (up). 
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Zooming the display 

1. Click  to enable the scaling. 

2. 2. Click the axis you like to scale. The mouse pointer becomes an arrow. 
 

 

3. While holding down the mouse button, move the mouse up/right to zoom the axis in, and move the mouse 
down/left to zoom the axis out. 
- OR -  
You can use the keyboard: Press LEFT ARROW or DOWN ARROW to zoom the axis out, RIGHT ARROW  
or UP ARROW to zoom the axis in. 
- OR -  
Use the PAGE UP and PAGE DOWN keys for a faster scrolling (larger steps): PAGE DOWN to zoom out, 
PAGE UP to zoom in. 

Size to fit 

 Click  to size the display to fit. The ranges are automatically adjusted to fit the maximum amplitude  
of each stimulus. The range of the time axis will be set to fit the longest signal. 
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8 Downloading Stimuli 

8.1 Downloading Stimulus Files 

After having set up the stimulus file, you can download the file to the connected STG. You can select  
the channels that you want to download or download the complete file.  

You can start the stimulation directly after the download, or start it manually with the software or 
hardware controls, or start it on a trigger. See also chapter "Operating the STG" for more information. 

 

Warning: Check the file thoroughly before downloading it on the STG. The stimulus display is 
independent from the worksheet and from the download. Verify that you download only the channels 
that you want to use. Do not start the STG if you are not sure about the channel configuration or the 
nature of the downloaded file. 

1. Select the channels for downloading under Download Channel and Download Sync. 
 

 

2. On the STG menu, click Download or click  on the toolbar to download only the selected channels 

onto the STG or Download and Start  to download only the selected channels and start the 
stimulation directly after the complete download. 

Disable / enable warning messages 

Cancel this option to disable the message boxes displaying compiler warnings during stimulus download. 

The two error messages that can be disabled are: "Warning: Signal length shorter than the maximum" and 
"Warning: Non zero last amplitude value". They may present a nuisance if you download multiple stimulus 
files in batch mode. 

 On the Settings menu, select or deselect Enable Compiler Warnings. 

8.1.1 Download Modes 

Default Mode 

When downloading files created in MC_Stimulus II software to a stimulus generator of the STG4000 series, 
two different download modes are available. In “Default mode”, for each download all channels are 
stopped and cleared before the new paradigm is downloaded. All available channels are downloaded one 
after the other regardless of the space each channel needs, which means that the available memory is 
optimally used. This mode should always be used when large and complicated stimulation patterns are 
used, for example white noise stimulation.  
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Independent Channel Download 

The second option is to use the feature “Independent Channel Download” which is available in the 
Settings menu. This feature allows downloading a new stimulation paradigm to individual channels 
only, while all other channels continue with their former program without stopping. To allow this, the 
memory space of the STG is divided among all available channels. For example, when using  
a STG4008, the memory is divided in 16 parts, for eight Sync Out channels and eight stimulation channels, 
so the memory space for each channel is more limited than in default mode. If a stimulation pattern is too 
large for the available memory partition, no download is possible.  

Note: It is recommended to operate the stimulus generator in default mode. The “Independent Channel 
Download” feature should only be used if one STG is connected to more than one recording system, and  
if those recording systems should be operated independently. 

8.1.2 Independent Channel Download 

The “Independent Channel Download” can be activated in the Settings menu. As mentioned above,  
it allows downloading of new paradigms to individual channels without stopping all other channels,  
but also leads to limited memory availability. 

 

This feature is primarily intended to be used with MEA-Systems with multiple amplifiers and only a single 
STG. See chapter “Operating multiple MEA amplifiers with one STG”. 

If the independent download option is active, a click on the Download or Download and Start button 
will only download a new paradigm to the channels selected in the Download Channel check box  
(1 and 6 in this example). Other channels will not be influenced. 

 

However, the individual download option is influenced by the Trigger Settings. To be able to download 
channels independently from each other, it is mandatory that these channels are assigned to different 
triggers.  

If a new paradigm is downloaded to one channel, all channels assigned to the same trigger will also  
be stopped, even though no new paradigm is send to this channel. 

Each time you change any parameter in the “Trigger Settings” dialog, the running stimulation will be 
stopped automatically. You have to start the stimulation again manually. 
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The following dialog appears when you change anything in the “Trigger Settings” dialog. Click “Yes” 
button to download on all channels, click “No” button to download on selected channels. 

 

 

8.2 Operating multiple MEA Amplifiers with one STG 

It is possible to operate more than one MEA amplifier independently with a single stimulus generator of 
the 4000 series. To do this, activate the Independent Channel Download feature in the Settings menu. 

 

This will allow you to download new stimulation paradigms to individual channels without interrupting the 
ongoing stimulation on other channels. See chapter “Downloading Stimulus Files” for more information. 

It is mandatory that all stimulation and Sync Out channels that are associated with one amplifier are 
assigned to the same trigger in the Trigger Settings menu. For example, if four MEA1060-BC amplifiers 
are connected to one STG4008, usually two stimulation channels and one Sync Out are associated to each 
amplifier. In that case, the trigger settings should be as shown: 

 

Amplifier A is connected to stimulation channels 1 and 2 and Sync Out 1, Amplifier B is connected to 
stimulation channels 3 and 4 and Sync Out 2, and so on. All channels connected to one amplifier are 
assigned to the same trigger.  
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To download a stimulation paradigm to individual channels assigned to one amplifier only, select all 
channels connected to this amplifier in the “Download Channel” check box (1 and 2 in this example)  
and Sync Out 1 in “Download Sync” check box, whether you changed them all or not!  

 

Only these channels will be downloaded, ongoing stimulation on other channels will not be interrupted.  

To start and stop only the channels associated with one amplifier, use the Start / Stop buttons for 
individual triggers. Each button controls one trigger and hence all assigned channels. The orange LED 
indicates ongoing stimulation. In our example, the configuration shown below would mean that 
amplifiers A, B and D are receiving a stimulation signal, while stimulation for amplifier C is stopped.  

 

Triggers 5 to 8 have no function in this example. You could download a new paradigm for amplifier D  
by downloading channels 5 and 6 and Sync Out 3, and then start it with the start button of Trigger 3.  
This would not interfere with the ongoing stimulation to the other three amplifiers, but only if the 
Independent Channel Download function is activated. If the STG is in default download mode,  
any download will stop all ongoing stimulation and empty the memory of the STG. See chapter 
“Downloading Stimulus Files” for more information. 
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9 General Software Features 

9.1 Customizing the Main Window 

You can customize the size and position of open file windows and the toolbar in MC_Stimulus II. 

 You can hide the toolbar and the status bar by deselecting them on the View menu. 

 You can arrange the windows with the commands on the Window menu. 

 Cascade: Use this command to arrange multiple opened windows in an overlapped fashion.  
The windows are resized to the standard size. 

 Tile: Use this command to arrange the windows so that they are not overlapping. 

 Arrange Icons: Use this command to line up minimized windows. 

 You can resize the windows with your mouse. 

 Click an empty area on the toolbar, and then drag the toolbar to a new position. 

9.2 Menu Bar 

You will find most software features in the pull-down menus of the main window. Each menu displays a list 
of commands. Commands that are not available at the moment appear shaded. 

Use the ... 

 File menu to create new files, save files, import ASCII files, and print the stimulus worksheet. 

 Edit menu for general editing features like copy and paste rows, remove the last entered value (Undo), 
remove and insert rows into the active worksheet. You can also right-click on a row and select these 
commands. Click Clear Signal to delete all values in the active worksheet. You can also specify the output 
ranges according to the connected STG on this menu. Please see the technical specifications of your STG. 

 The STG menu contains all commands directly relating to the hardware, for example download commands, 
start and stop the STG, and trigger configurations.  

 You can open, start, and stop a batch run of several files on the Batch menu. 

 Signal menu for nice editing features like editing whole columns, and autocreate signals. You can also 
right-click on a column and select these commands. 

 View and Window menu to customize the main window. 

 Settings menu to define general settings of the software. 

 Help menu to open the MC_Stimulus II Help and to display the About dialog where you can find 
information about the hardware, software, and firmware versions. You will need this information when  
you contact the support. 
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9.3 Toolbar 

For your convenience, you will find some of the more commonly used commands as a button  
on the toolbar. 

 

 
New File Creates a new MC_Stimulus II file (*.stm) file. 

 
Open File Opens a previously saved MC_Stimulus II file (*.stm) file. 

 
Save File  Saves the *.stm file to the chosen destination. 

 
Cut Row Deletes selected row(s) and sends deleted row(s) to clipboard. 

 
Copy Row Sends selected row(s) to clipboard. 

 
Paste Row Pastes row(s) from clipboard and overwrites row(s) starting  

at the selected row. 

 
Print Prints active channel of active worksheet. 

 
Information Opens the About dialog, where you can find information  

about the hardware, software, and firmware versions. 

 
Download Downloads stimulation file to the connected STG (only available  

if STG has active computer connection). 

 
Download and 
Start 

Downloads and starts stimulation file to the connected STG (only available  
if STG has active computer connection). 

 
Start Starts downloaded stimulation file (only available if STG has active computer 

connection). 

 
Stop Stops downloaded stimulation file (only available if STG has active computer 

connection). 

9.4 Shortcut Keys 

Shortcut keys offer you another way to accomplish common tasks. Using a shortcut key usually consists  
of pressing and holding one key while pressing a second key. 

See the list of shortcut keys available in the software. 

Shortcut key  

CTRL+C Copy Row 

CTRL+D Download 

CTRL+A Download and Start 

CTRL+N Create New File 

CTRL+O Open File 

CTRL+P Print 

CTRL+R Start 

CTRL+S Save file 

CTRL+T Stop 

CTRL+V Paste Row 

CTRL+X Cut Row 

CTRL+Z Undo 
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Hint: Shortcut key combinations are also listed on the toolbar menus. For example, the File menu shows 
that the shortcut key for Save is CTRL+S. 

9.5 File Menu 

You can save MC_Stimulus II files for later use. This is very convenient if you have various similar 
experimental setups, or if you like to repeat an experiment later. 

Open a file 

You may open previously saved files for similar experimental setups. 

1. On the File menu or on the toolbar, click Open . 

2. Browse your folders and choose the desired file. You may only open MC_Stimulus II files (*.stm). 

3. Click Open. The selected file opens. 

Save a file 

1. On the File menu or on the toolbar, click Save . The currently active worksheet is now saved. 

You may open the file using MC_Stimulus II later on to continue your experiment. 

Save as 

Use this command to save your file under a new name, for example, if you like to use a file as  
a template for a new file. 

1. On the File menu, click Save As. 

2. Browse your folders and enter a file name. 

3. Click Save. The current worksheet is now saved under the new name. 

You may open the file using MC_Stimulus II later on to continue your experiment. 

Import ASCII File 

Please see the chapter "ASCII Import / Export". 

Export ASCII File 

Please see chapter "ASCII Import / Export" 

Printing a channel 

1. On the File menu, click Print Setup to select a printer, paper format, and so on. 

2. Click Print Preview to preview the print output. 

3. Click Print   to print out the active channel of the active worksheet. 
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9.6 Settings Menu 

Enable Compiler Warnings 

Cancel this option to disable the message boxes displaying compiler warnings during stimulus download. 

The two error messages that can be disabled are: "warning: signal length shorter than the maximum" and 
"warning: non zero last amplitude value". They may present a nuisance if you download multiple stimulus 
files in batch mode, or if you want to adjust the stimulus intensity level on the fly. 

 On the Settings menu, select or deselect Enable Compiler Warnings. 
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10 Synchronizing Events 

10.1 Digital Output Signals (Sync Out) 

The output of the digital Sync Out outputs is a 3.3 V TTL signal. A logic state of 1 means 3.3 V, and  
a logic state of 0 means 0 V. Please note that the digital output is about 15 μs faster than the analog 
output. This small offset is generally sufficient to make sure that the Sync Out signal precedes the 
stimulation, which is important for synchronizing events. 

You can program the output signal of the Sync Out channels in the same way as the analog output signals, 
but due to the nature of a digital signal, only values of 0 and 1 are allowed. A Sync Out signal is generated 
each time when the STG is started. 

The output signal can be used for triggering external devices, for example, the data acquisition with  
the MC_Card of the ME-System and the MEA-System. Please note that if you use it for triggering the 
MC_Card, you should use output signals that have a duration of at least 200 μs otherwise it can happen 
that the MC_Card ignores trigger events. 

All four Sync Out outputs are active when the STG is started by pressing the Start / Stop button, or by 
using the software command Start on the STG menu. 

If you are using the Trigger In inputs for starting the STG, each of the four Sync Out channels  
is controlled by a separate Trigger In channel. Sync Out 1 is active when Trigger In 1 is triggered, Sync  
Out 2 is active when Trigger In 2 is active, and so on. The assignment of Sync Out channels to Trigger In 
inputs can be customized, please see Trigger Settings. 

If you use the Repeat feature in the Trigger Settings dialog box, the corresponding Sync Out signal  
is repeated as well as the selected analog output signals. 

You can, for example, synchronize four separate displays or other virtual instruments in MC_Rack, one for 
each trigger input. You can also define a bit pattern in the Trigger Detector and trigger instruments on 
this bit pattern, for example to activate virtual instruments only when trigger 1 and 3 are active at the same 
time. Please see the MC_Rack help or manual for more information on the Trigger Detector and 
triggering. 

Note: No Sync Out signal is sent when the STG is stopped on a trigger event or by pressing the Start / 
Stop button, that is, if the trigger event occurs or the button is pressed when the STG has still been active. 

Timing of blanking signal 

If you have a MEA amplifier with blanking circuit in use, you can apply a blanking signal (TTL pulse) for 
transiently switching off the input stage of the amplifiers during the stimulus, thus avoiding the stimulus 
artifact. 

MCS recommends a minimum blanking pulse that starts with the stimulus and stops 100 μs after the 
stimulus. The fact that the digital output of the stimulus generator from MCS is about 15 μs faster than 
the analog output ensures that the blanking signal is delivered before the stimulus. It is very important that 
the blanking pulse is delivered shortly before the stimulus. 



Stimulus Generator 4000 Series Manual 

58 

The following example shows a blanking signal (programmed with MC_Stimulus II) of 300 μs length for a 
biphasic pulse of 200 μs length. See also the MEA_Select help or the “MEA Amplifier with Blanking Circuit” 
manual for more information. 

 

You can use the Auto Sync feature for autocreating the Sync Out pulses without entering values manually. 
Please see "Auto Sync for Autocreating Synchronous Sync Out Pulses". 

10.2 Triggering Stimulation (Trigger In) 

The external trigger input has to be a TTL signal of at least 40 +/- 10 μs length. TTL pulses shorter than 
that may not be recognized by the stimulus generator. 

A TTL pulse is defined as a digital signal for communication between two devices. A voltage between  
0 V and 0.8 V is considered as a logical state of 0 (LOW), and a voltage between 2 V and 3.3 V means  
1 (HIGH). It is the same kind of signal as the output signal of the Sync Out output of the STG. 

The rising edge of the HIGH trigger input starts and stops the STG. The time lag between the rising edge 
of the TTL input and the stimulus output is 70 +/- 10 μs. The minimum distance between two trigger 
inputs is 100 μs, resulting in a maximum trigger frequency of 10 kHz. If a higher frequency is used, the 
stimulus generator is likely to miss trigger inputs. See the illustration below for more details on the timing. 
Please note that the digital Sync Out output is about 15 μs faster than the analog outputs. See Digital 
Output Signal (Sync Out) for more information. 

You can either trigger separate output channels (Standard mode) or separate MC_Stimulus II files (Multi-
File mode). 

There is also one separate Sync Out output for each trigger input. You can assign the Sync Outs to the 
trigger inputs in the Trigger Settings dialog box. The default settings are that Sync Out 1 is active when 
Trigger In 1 is triggered, Sync Out 2 is active when Trigger In 2 is active, and so on. See also "Digital Output 
Signals" for more information on the Sync Out channels. 

The Sweep status display (LED Start / Stop buttons) in the main window  
of the program shows active sweeps that were started by the triggers. That means, the status lamp that 
corresponds to trigger 1 lights red as long as any channel triggered by trigger 1 is active. Please note that 
the number of the analog output channel is irrelevant, the Sweep status lamp refers only to the trigger 
number. Example: Assume that channel 4 is assigned to trigger 1. When channel 4 is active, the first 
Sweep lamp lights red, because the first Sweep lamp refers to trigger 1. 
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You can start and stop the trigger manually at any time using the LED Start / Stop buttons. 

 

Custom switch for "remote-controlling" of the STG 

You can connect any device that produces TTL outputs to the Trigger In connector of the STG, for example 
a switch. For example, you can use a trigger for remote controlling the STG if it is not within reach during 
an experiment. It is also possible to set up advanced experiments where stimulation depends on preceding 
activities of the studied object. 

The following picture shows a suggested circuit diagram for a switch used for remote controlling. The 
resistor and capacitor work as a low-pass filter on the TTL signal and are necessary to reduce ringing of  
the signal. 
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10.3 Trigger Settings 

Triggering output channels (Standard mode) 

You can use up to four or eight separate trigger inputs for triggering up to four or eight output channels 
(STG4004 or STG4008, respectively).  

The trigger settings are saved in the currently active MC_Stimulus II (*.stm) file. Please assign the four 
triggers to the analog output channels in the Trigger Settings dialog box in the Edit menu. 

 

In the preceding example, trigger input 1 is used to trigger the output channels 1, 3, and 6. This means, 
each time a TTL pulse is applied to Trigger In 1, stimulation on channels 1, 3, and 6 is started 
simultaneously. The complete protocols of these three channels would be executed three times after the 
trigger event, if continuous mode would be off. However, as continuous mode is activated, trigger repeats 
are disabled and the protocols will be repeated indefinitely, until a manual stop occurs.   

Important: Only channels assigned to the same trigger have the same time base. Between channels 
assigned to different triggers, time shifts in the order of the STGs time resolution (20 μs) may occur.  

The Sync Out outputs are assigned to their default trigger inputs, that is, Sync Out 1 is active when trigger 
1 is active, and so on. You can change this assignment with the option buttons, for example, assign 
multiple Sync Outs to the same trigger. 

The Sweep status light (LED Start / Stop buttons) indicates the trigger numbers that have been assigned  
to active channels. 

Example: If channels 1 and 3 are assigned to trigger 1, and trigger 1 is started (either by the software 
controls, the Start button on the stimulus generator's front panel, or the trigger input 1), the first Sweep 
status lamp indicates the active state of channel 1 or 3, even if one of the two channels has a shorter 
output sweep than the other and is not active anymore. 
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Triggered action when channel(s) still active 

You can define what action should be taken when any of the channels assigned to the trigger  

are still active. Please click the expand button  to show the advanced options: 

 

Stop: A following trigger input stops the stimulation on the assigned channels if at least one channel  
that has been assigned to this particular trigger is still active in the moment of the trigger event. The trigger 
event starts stimulation only if no channel that has been assigned to this trigger is active. 

Restart: The stimulus protocols on all channels assigned to this trigger are started at the trigger event, 
regardless of the activity on these channels. 

Ignore: The trigger event is ignored when any channel assigned to this trigger is active. The trigger event 
starts stimulation only if no channel that has been assigned to this trigger is active. 

Use Trigger as Gate  

Channels associated with a Trigger input will be active as long as the condition of that trigger is 1 (HIGH) 
and switched off as soon as the condition becomes 0 (LOW). If the stimulation protocol is shorter than  
the gate, it will stop at the predefined time, regardless of the gating trigger. If the stimulation protocol  
is longer than the gating trigger, stimulation will stop when the gating trigger ends. For example, if you 
want to produce a repeated rectangular pulses that last as long as the gating trigger is HIGH, you can do 
the following: program a single rectangular pulse and activate the continuous mode. The pulses will start  
as soon as the gating trigger becomes HIGH, and stop as soon as the gating trigger becomes LOW. If the 
voltage of the stimulation channel is different from 0 at the time the gating trigger ends, the channel will 
be switched off immediately. If you stop the stimulating protocol manually during the gating trigger in 
HIGH, stimulation is stopped but immediately restarted, and goes on until the gating trigger ends. 

 

Warning: Once selected, this setting will become the default setting for all opened files, until unselected. 
So if you observe unexpected behaviour when triggering the STG, check the Trigger settings. 

 

Single Trigger 

Important: This feature is available only with STG4000 series. The MC_Stimulus II version 3.2.3 (or later) 
with firmware update must be installed.  

Additional to the general trigger states “running” and “stopped” each trigger can now be set up in a new 
state, called “armed”. That means, the trigger is ready to start the stimulus protocol, but waiting for an 
external signal from the rear panel trigger inputs to execute the stimulus protocol one time only. In 
“armed” state, the “Sweep” LED on the front panel of the STG will light up, but the brightness of the LED 
is not as brilliant as in “running” state. 
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Select “Single Trigger” if you want to start the stimulus protocol once via external trigger. 

 

Set up your stimuli with the MC_Stimulus II program. Download the stimulus protocol from a MC_Stimulus 
II file to the STG. Arm the STG either manually by pressing the Start / Stop button on the front panel,  
or with software controls. To arm the STG via software, use the start icon  

in MC_Stimulus II main menu, or click the combined LED / Start / Stop button     
for the “Sweeps”. When armed, the STG accepts one single trigger on its trigger input. The trigger input 
must be connected to the device which generates the trigger. To start the stimulus protocol a second time, 
the STG needs to be armed again manually. As long as the STG is armed, the LED in MC_Stimulus II 
appears blue to indicate the armed state.  

The stimulation will automatically be started after applying the single trigger from the external device.  
The LED in will turn to red while the trigger is running and return to grey after the trigger has finished  
the stimulus protocol The STG needs to be armed again to accept the next trigger. 

 

It is possible to stop the stimulation at any time while the STG is armed or is running via Start / Stop button 
on the front panel of the STG or via software.   

Sweep Count 

The number of sweeps are counted and displayed for each of the triggers at the bottom  
of the main window.  

 

Please note that not the number of stimuli but the number of sweeps is counted, whereby one sweep  
is defined as one complete run of the programmed stimulation pattern, as displayed in the main window. 
So, if five stimuli are programmed, and the repeat rate in the Trigger Setting menu is set to six, 30 stimuli 
will be delivered but the sweep count will be six. 

Sweeps are not counted online, the final number is displayed after the STG has been stopped. The 
number of sweeps per channel is not put to zero automatically every time the stimulation is started. 
Instead, a reset only happens if a trigger is again used in the new stimulation. So, if a stimulation file  
uses trigger one and two with a repeat of three each, the display will show 1:3 2:3 3:0 4:0 at the end  
of the stimulation. If afterwards for example a stimulation file is started which uses only trigger four  
in continuous mode, and this file is stopped after 15 repeats of the programmed stimulation pattern,  
the display will show 1:3 2:3 3:0 4:15.      
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10.4 Multi File Mode 

As an alternative to triggering separate channels in a single stimulus protocol, you can also trigger up to 
four separate stimulus files in the Multi-File mode. This feature allows you to trigger different stimulus 
protocols on overlapping channels. For example, you can control stimulus pattern A by trigger 1 on 
channels 1 and 2, and stimulus pattern B by trigger 2 on channels 2 and 3, and so on. 

The Multi-File mode is indicated in the MC_Stimulus status control bar in the main window. If you use the 
Multi-File mode, you cannot use the trigger inputs anymore for triggering single channels. When you start 
the download, all selected up to four stimulus files are downloaded onto the stimulus generator. When 
Trigger In 1 is active, the file assigned to Trigger 1 is started (with all downloaded output channels); when 
Trigger In 2 is active, the file assigned to Trigger 2 is started, and so on. You can choose what action 
should be taken when a trigger event occurs during the time when the assigned file is still playing. 

If the STG is started by the START / STOP button on the front panel or the Start command of 
MC_Stimulus II, only the first / top selected file (this is usually the file assigned to trigger 1) in the Trigger 
Settings dialog box is started. (For downloading and starting multiple files without triggering, please use 
the Batch Mode.) 

Important: As long as you are in the Multi-File mode, the Standard trigger settings (trigger inputs 
assigned to single channels) will have no effect. You also cannot close files if you are in Multi-File mode. 
Please leave the Multi-File mode by selecting Standard under Mode in the Trigger Settings dialog box 
to use the standard trigger settings or before closing files. 

Please read also chapter "Extended Multi File Mode". 

 

1. Connect all necessary trigger inputs to TTL signal sources. 

2. Set up your stimulus protocols and save the files. 

3. On the Edit menu, click Trigger Settings. 

4. Select the option Multi-File. 

5. Under Trigger 1, click Browse and select the appropriate stimulus protocol that you want to assign  
to trigger 1. 

6. Repeat step 5 for all necessary trigger inputs. Confirm the settings by clicking OK. 

7. All selected files are opened automatically. 

8. Check all stimulus protocols before download. Please make sure that you have selected all necessary 
channels under Download Channel for each file separately. 
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9. Download the files onto the STG by clicking Download on the STG menu. 

10. The stimulation as specified in the selected MC_Stimulus files will now be triggered by the selected trigger 
inputs (Trigger In 14). 

Triggered action when channel(s) still active 

You can define what action should be taken when any of the channels assigned to the trigger are still 
active. In addition, you can also define what action should be taken when any of the channels not assigned 

to the trigger event are still active. Please click the expand button  to show the advanced options: 

 Stop:  A following trigger input stops the stimulation on the assigned channels if at least one channel that 
has been assigned to this particular trigger is still active in the moment of the trigger event. The trigger 
event starts stimulation only if no channel that has been assigned to this trigger is active. 

 Restart: The stimulus protocols on all channels assigned to this trigger are started at the trigger event, 
regardless of the activity on these channels. 

 Ignore: The trigger event is ignored when any channel assigned to this trigger is active. The trigger event 
starts stimulation only if no channel that has been assigned to this trigger is active. 

Example: 

File A is assigned to trigger 1 and file B to trigger 2. Consider the following two situations: 

 Trigger 1 is activated, but channel 3 in file A is still active. As channel 3 from file A is assigned to trigger 
1, the settings defined for "on channel assigned to same trigger" would be applicable. 

 Trigger 1 is active, but channel 3 in file B is still active. As channel 3 from file B is assigned to trigger 2,  
the settings defined for "on channel assigned to other trigger" would be applicable.  

10.5 Extended Multi File Mode 

The Extended Multi File Mode is a very flexible mode for advanced users. It can be used with stimulus 
generators of the 4000 series with a digital IN / OUT connector only that means, STG 4004 and STG 4008. 
It is possible to download up to nine different stimulus patterns in the default setting of the Extended Multi 
File Mode. Selecting the option "Show all Patterns" the program supports 256 different patterns of 
stimulation. You can download up to 256 stimulus patterns in advance and select among them. You can 
use one of these stimulus patterns at a time of your choice with a digital signal. Please read also chapter 
"Multi File Mode". 

This high number of different stimulus patterns are selected via the digital IN / OUT connector. Please  
see the pin layout of the 25-pin D-Sub connector in the appendix. Pin 1 to pin 8 of the connector refer  
to digital input D0 to D7. Pin 9 to pin 16 refer to digital output D8 to D15, but they are not connected.  
Pin 17 to pin 25 are grounded. If you do not use all eight digital inputs, you have to connect them to 
ground manually, otherwise they count like 1 = high. It is recommended to build a connector. 

All channels are assigned to trigger 1. Please make sure that you do not use any other trigger input.  

Each time when trigger 1 is activated, the program applies that one of the stimulus pattern which currently 
is selected by D0 to D7. 
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Assignment of the digital inputs D7 to D0: 

 

The user is asked to compose his own stimulation pattern files. Please do not create too big stimulus files, 
because all files are completely downloaded, and stored in the memory of the STG. If the files contain too 
much data, and you apply a lot of files, you will get an error message on download. The advantage of this 
mode is to have all stimulus files directly in the memory of the STG, and thus there is no time lag when 
starting a new stimulus pattern on each trigger. 

 

To arrange the created stimulation files, you have to click on the grey square on the right side of each  
row. A dialog will open, and you can choose the file you want to place in this position. The complete 
arrangement of the files can be saved as “Extended Multi File” configuration file with the command 
"Save", and load again with "Load". The configuration file for the “Extended Multi File Mode” has  
the extension *.mf2. 

When using the option "Show all Patterns" it would be hard to fill in files to each of the 256 positions.  
You can shorten the procedure by editing an available “Extended Multi File” with a common editor.  
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Please make sure to use the correct format.  

 

1. Connect the digital IN /OUT connector to a TTL signal source. 

2. Ground digital inputs manually which are not used. 

3. Set up your own stimulus protocols, either nine stimulus patterns or up to 256 patterns, and save the files. 

4. On the Edit menu, click Trigger Settings. 

5. Select the option Extended Multi-File. 

6. Optionally select the check box "Show all Patterns". 

7. Define the desired files to each of the positions, or load a configuration file (*.mf2) for the “Extended Multi 
File” mode. 

8. Close the dialog by clicking "OK". 

9. All selected files are opened automatically. 

10. Check all stimulus protocols before download. Please make sure that you have selected all necessary 
channels under Download Channel for each file separately. 

11. Download the files onto the STG by clicking Download on the STG menu. 

12. The stimulation as specified in the selected MC_Stimulus II files will now be triggered by trigger input 1. 
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10.6 Batch Mode 

You can download and run several stimulus files one after the other in the Batch mode. The first file  
in the list is downloaded and started directly after the download, or started manually with the software  
or hardware controls, or started on a trigger. After the first file has been run, the next file in the list is 
downloaded, and so on, until the last file in the batch list has been run. 

Triggering a sequence of stimulation protocols 

The Batch mode is useful if you want to start a sequence of different stimulation protocols one after the 
other on the same trigger (Trigger 1). Please make sure that you have assigned all channels to Trigger 1 in 
the Trigger Settings dialog box. You set up the protocols and save them as separate stimulus files. Then, 
you set up a batch file with a list of the desired stimulus files. 

 The first trigger event starts the first file in the list. 

 When a file has been completed, the next file in the list is downloaded automatically. 

 When a trigger event occurs after the file has been run, the next file is started, and so on. 

 When a trigger event occurs during the run of a file, the run is stopped, and the next file in the list  
is downloaded. The next trigger event starts the next file. 

 Deselect the option Start STG after Batch Download on the Settings menu if you want to start the 
protocols on a trigger or manually with the software or hardware controls. If the option Start STG after 
Batch Download on the Settings menu is selected, the STG starts each file directly after the download 
without waiting for a trigger event. 

As an alternative to the Batch mode, you can also use separate trigger inputs to trigger separate output 
channels or separate stimulus files. This way, you can trigger up to four different pulse protocols (on 
separate channels). See chapter "Triggering Stimulation" for more details. 

Note: Only Trigger 1 is available for triggering in Batch mode. Do not use any other trigger inputs. 

Splitting up stimulation protocols to circumvent the memory limitation 

If the option Start STG after Batch Download on the Settings menu is selected, the STG starts each file 
directly after the download, which is only useful in the (unlikely) case that you need to circumvent the 
memory limitation of the STG. Split up your pulse protocol into several stimulus files and run them in Batch 
mode. 

Setting up a batch file 

You have to set up a batch file (.stb) first, which lists the full path of all files that you like to download  
as a batch. The batch file has to be exactly in the following format. This example is a batch list with  
three different pulse protocols. Replace the file paths with the correct path of the files of your choice. 

Multi Channel Systems MCS MC_Stimulus 
Batch Control File 
Version 1.00 
c:\Program Files\Multi Channel Systems\MC_Stimulus 
II\BatchExample\Baseline.stm 
c:\Program Files\Multi Channel Systems\MC_Stimulus 
II\BatchExample\Tetanus.stm 
c:\Program Files\Multi Channel Systems\MC_Stimulus 
II\BatchExample\TestResponse.stm 
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Operating the STG in Batch mode 

Important: You can operate the STG in Batch mode only with a valid computer connection.  
A file in the batch list is only downloaded after the preceding file has been run. 

1. On the Batch menu, click Open to open a batch file. The Open dialog box appears. 

2. Browse your folders and select a valid batch file, for example the sample file TetanusBatch.stb  
in the MC_Stimulus II program folder. 
 

 

3. The Batch Status Display opens. It lists all stimulus files in the batch and the duration of stimulation. 
 

 

4. On the Batch menu, click Start to start the download of the first file in the batch list (and the STG if the 
option Start STG after Batch Download on the Settings menu is selected).The progress of the pulse 
protocol is displayed in the Status column of the Batch Status Display. 

5. Click Stop on the Batch menu to stop the batch if necessary. 

6. Close the Batch Status Display with the Close command. 

 

Warning: The STG starts immediately after the download if the option Start STG after Batch 
Download on the Settings menu has been selected. Make sure to deselect this option if you do not 
want to start the stimulation right away. 

Autorepeat option 

If you select the Autorepeat Batch Mode option on the Settings menu, the batch is restarted with  
the first file after the last file in the batch has been finished. 
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11 Analog Output Signals 

11.1 Output Modes 

The stimulus generator operates in voltage and current mode. Choose voltage or current mode in the  
main window of MC_Stimulus II. Please make sure that you use the appropriate stimulation mode for  
your experiment. The difference between current and voltage controlled stimulation is described in the 
following. 

In voltage mode, the voltage level is held constant and the current output depends on the electrode 
resistance (the higher the electrode resistance, the lower is the output current). 

In current mode, the stimulus generator guarantees a stable current output independent of the electrode 
resistance, where the voltage is defined by Ohm's law. The higher the electrode resistance, the higher is 
the output voltage. Therefore, the kinetic properties of the stimulus output is affected by the load 
resistance, which is usually the electrode resistance. If the resistance is too high, the output current is 
limited by the compliance voltage, that is, too high resistances will result in a clipping of the output 
signal. 

Please consider the time and voltage / current resolution of the stimulus generator. The minimum pulse 
has an amplitude of 1 mV in voltage mode or 200 nA in current mode (supported by MC_Stimulus II; the 
firmware / DLL supports a 14 bit resolution, which means 200 nA for an output current range of 0.8 mA, 
and a time length of 20 μs. Please note that if you work near these limits, that is, if you use very small 
amplitudes or very short pulses, the output waveform may not exactly match the programmed waveform. 

Resolution Limits 

 

Ground 

All stimulation channels of the STG are optically isolated from each other. Each channel has an 
independent ground (GND), which is usually connected to the ground of the experimental setup,  
for example, the amplifier, so that all devices refer to the same ground. Please make sure that you always 
use the appropriate ground for the channel in use. 
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11.2 Voltage Mode 

 If you want to operate the STG in voltage mode, you have to select "Voltage" in Output Mode of the main 
window of MC_Stimulus II. You will usually use the + and GND outputs. The output signal is identical with 
the programmed signal in the normal ranges of the electronics' accuracy. See illustration "Voltage mode: 
Standard Setup". 

 The output signals are inverted (multiplied by -1) if you use the - outputs.  

 If you use the voltage between + and -, the output signal amplitude is doubled. The - represents the 
ground (replaces GND) in this case. See illustration "Voltage mode: Doubled output signal amplitude". 

 A bipolar stimulation is recommended for extracellular recordings from microelectrode arrays (MEAs)  
if a very high output signal density in a defined area between two neighboring stimulating electrodes  
is needed. The current that is delivered by the first electrode flows directly back to the second electrode  
so that the surrounding tissue is not affected. See illustration "Voltage mode: Bipolar stimulation". 

 In the following example, you see a signal in the MC_Stimulus II display and the resulting output signals 
for the different connection options (viewed in a MC_Rack Data Display). 

Programmed stimulus protocol viewed in MC_Stimulus: 
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STG output signals: 
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Screen shot from a standard oscilloscope triggered on the Sync Out pulse (see "Measuring output signals 
with an oscilloscope"). Green trace = voltage output (+U), red trace = inverted voltage output (-U), pink 
trace = TTL output from the Sync Out. 

Voltage output 1 V and Sync Out. 
 

 

The time lag between the Sync Out output, the trigger, and the voltage output is approximately  
15 μs (+/- 2 μs) 

Setup suggestions for voltage mode 

The following illustrations show circuit diagrams of suggested setups. Please note that you can use 
unshielded twisted pair cables (wires twisted round each other) instead of a shielding to prevent the 
amplifier from picking up noise. The experimental ground can be, for example, the amplifier's ground  
or a Faraday cage. 

If you use the stimulus generator together with a standard MEA amplifier, you can also use the provided 
3-polar cable for directly connecting the stimulus generator to the electrode inputs of the MEA amplifier. 
Please note that a shielded cable is generally not necessary if you use a MEA1060 amplifier with blanking 
circuit. For more details on the recommended setup for this amplifier type, please refer to the “MEA1060 
Amplifier with Blanking Circuit User Manual”. 



Analog Output Signals 

73 
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11.3 Current Mode 

 If you want to operate the STG in current mode, you have to select "Current" in Output Mode of the main 
window of MC_Stimulus II. You will usually use the + and GND outputs. See illustration "Standard setup". 

 The output signals are inverted (multiplied by -1) if you use the - outputs. 

If the load resistance, that is, the electrode impedance is very high, the output voltage can get  
very high, too. The stimulus generator limits the output voltage to 75 V between + or - and GND.  
The guaranteed compliance voltage is +/- 60 V, that means 120 V between + and -. 

 The current output of the STG is limited by the compliance voltage and the electrode impedance.  
If the maximum load resistance for a given current output is exceeded, the compliance voltage (60 V 
between +I and GND) of the STG will not be sufficient for delivering enough current, and the output will  
be clipped. You can calculate the maximum load resistance by Ohm's law. For example, if you want to 
program a 100 μA pulse, the maximum load resistance will be 600 k. According to Ohm's law: R = U / I = 
60 V / 100 μA = 600 k�, that is, 60 V are sufficient for delivering a current of 100 μA at a load resistance 
of 600 k���Therefore, if you use current driven stimulation, you should always take the impedance of the 
stimulating electrodes into account when planning your stimulus protocol. You should also keep in mind 
that most electrodes or amplifiers support only limited voltages. 

 You can increase the compliance voltage to 120 V by using the + and – outputs. The output current even 
at the maximum output voltage of 150 V should not be dangerous to human health because the maximum 
output current in current mode is only +/-1.6 mA. See illustration "Doubled maximal output voltage". 

 A bipolar stimulation is recommended for extracellular recordings from microelectrode arrays (MEAs) if a 
very high output signal density in a defined area between two stimulating electrodes is needed. The current 
that is delivered by the first electrode flows directly back to the second electrode so that the surrounding 
tissue is not affected. See illustration "Dipolar stimulation". 

Screen shot from a standard oscilloscope triggered on the Sync Out pulse (see "Measuring output signals 
with an oscilloscope"). Green trace = current output (+I), red trace = inverted current output (I), pink trace 
= TTL output from the Sync Out. 
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Current output 200 μA and Sync Out. 

 

The time lag between the Sync Out output and the current output is approximately 15 μs (+/- 2 μs)  
if continuous mode is enabled and 50 μs (+/- 2 μs) if continuous mode is disabled.   

 

Setup suggestions for current mode 

The following illustrations show circuit diagrams of suggested setups. Please note that for current 
stimulation, you should use shielded cables to protect your setup against electromagnetic interference.  
The experimental ground can be, for example, the amplifier's ground or a Faraday cage. 
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11.4 Measuring Output Signals with an Oscilloscope 

For test purposes, you can measure the output signals with an oscilloscope. Please see the appendix for the 
pin layout of the sockets on the front panel of the STG4000 series. 

Most standard oscilloscopes have a probe with a ground cable. This probe is usually connected to the 
oscilloscope via a BNC socket. What you do for measuring the voltage output is the following: Choose 
voltage mode in the main menu of the MC_Stimulus II software. You plug in the standard STG cables into 
the +U output and the corresponding GND output. You then touch the open end of the cable from the +U 
output with the probe from the oscilloscope, and the open end of the cable from the GND output with the 
ground cable from the probe. This means you measure the potential difference between the +U output 
and ground. 

Please note that you need a resistor in parallel to measure the current output properly because 
oscilloscopes measure voltages. If the input resistance of the oscilloscope is too low, the voltage output  
of the STG will be small as well, and you will not see any signals on the oscilloscope. MCS recommends  
a resistor of 10 k because the output signal of the current output should then be identical to the output 
signal of the voltage output. You can use the same test protocol (regardless of the output mode) for the 
current and voltage outputs, and compare the signals. As an alternative, you can also use a resistor that 
mimics the electrode resistance for testing your experiments. 

Choose current mode in the main menu of the MC_Stimulus II software. What you do is, you plug in cables 
into the +I output and into the GND output of the STG. You then use alligator crimps for connecting  
a 10 k resistor between the two open ends of the cables. You then touch the cable on one side of the 
resistor with the probe and on the other side with the ground of the probe. (Alternatively use the provided 
cable with integrated 10 k resistor). That is, you measure the potential difference over the resistor. 
You can then calculate the current output according to Ohm's law (U = R * I). For example, if you stimulate 
with 100 μA, the voltage over the 10 k resistor has to be U = 10000  * 0.1 mA = 1000 mV = 1 V. 

The following illustration shows four possible combinations of connecting the current outputs on the front 
panel of the stimulus generator to the oscilloscope. Again, it is important that unused current outputs are 
connected to ground. 

Measuring current output signals with an oscilloscope 

 

11.5 Rise Time 

The rise time of the voltage output is constant and independent from the stimulus protocol. The rise 
time of the current output is no fixed hardware property. The kinetics depend on the amplitude of the 
current pulse and the load resistance, that is, generally the electrode impedance. The resistance affects 
the kinetics much stronger than the amplitude. 

Generally, this does not make much difference for biological applications. If you have very time-critical 
applications, or if you use very short pulses, you should check the output of the STG with an 
oscilloscope before starting the experiment. 
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Amplitude dependency of rise time 

The rise time is independent from the current amplitude in the common range of amplitudes. The rise time 
(10 % /90 %) was measured with increasing current amplitudes (100 μA to 1600 μA) and a constant load 
resistance of 10 k. The output current is nearly constant up to amplitudes of 1100 μA, but increases 
about 0.3 μs until the maximum of 1600 μA amplitude is reached. The relationship is not linear as shown 
by the following curve. 

 

Resistance dependency of rise time 

The higher the load resistance, the higher will be the rise time. The rise time (10 % / 90 %) was 
measured with increasing load resistances and a constant current amplitude of 50 μA. For 50 μA pulses,  
the relationship is linear up to the maximum load resistance (please see "Current Mode") as shown by the 
following curve. Not shown are the results of the same measurement under the same conditions, except of 
the amplitude with a constant current amplitude of 100 μA. Up to a load resistance of 450 k, the results 
are congruent with 50 μA amplitude. 



Stimulus output comparison 

The following figures are examples for demonstrating how the amplitude and resistance will affect the 
kinetics of a current pulse. These images document also that in contrast to the current mode, in voltage 
mode, the rise time is constant and not dependent on the amplitude or load resistance. 

The graphs were generated by a standard oscilloscope. The devices were set up according to the 
recommendations under "Voltage Mode" and "Current Mode". The same pulse protocol and the same 
channel number of the STG outputs were used for measuring the voltage and the current output.  
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Example 1a: Voltage Mode: The green trace shows the voltage (+U) output; and the pink trace shows  
the TTL output from the Sync Out that was used for triggering the oscilloscope 

Rise time with programmed 500 mV and 50 μA pulses, 10 k load resistance.  
Rise time (10 % / 90 %) = 3 μs 


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Example 1b: Current Mode: The green trace shows the current output (+I) with a load resistance  
of 10 k; and the pink trace shows the TTL output from the Sync Out that was used for triggering  
the oscilloscope 

Rise time with programmed 500 mV and 50 μA pulses, 10 k load resistance.  
Rise time (10 % / 90 %) = 3 μs 

 

Result of Example 1: The rise time is about 3 μs for the 500 mV voltage pulse, and about 3 μs  
for the 50 μA current pulse. 
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Example 2a: Voltage Mode: The green trace shows the voltage (+U) output; and the pink trace shows 
the TTL output from the Sync Out that was used for triggering the oscilloscope 

Rise time with programmed 5 V and 500 μA pulses, 10 k load resistance. Rise time (10 % / 90 %) = 3 μs. 
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Example 2b: Current Mode: The green trace shows the current output (+I) with a load resistance of  
10 k; and the pink trace shows the TTL output from the Sync Out that was used for triggering the 
oscilloscope 

Rise time with programmed 5 V and 500 μA pulses, 10 k load resistance. Rise time (10 % / 90 %) = 3 μs. 

 

Result of Example 2: The kinetics and the rise time of the 5 V voltage pulse are comparable  
to the 500 mV pulse. The approximate 3 μs rise time of the 500 μA current pulse is not higher  
than the rise time of the 50 μA pulse.  
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Example 3a: Current Mode: The red trace shows the current output (+I) with a load resistance of 100 k; 
and the pink trace shows the TTL output from the Sync Out that was used for triggering the oscilloscope 

Rise time with programmed 5 V and 500 μA pulses, 100 k load resistance.  
Rise time (10 % / 90 %) = 12 μs. 
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Example 3b: Current Mode: The green trace shows the current output (+I) with a load resistance of  
1 M; and the pink trace shows the TTL output from the Sync Out that was used for triggering the 
oscilloscope 

Rise time with programmed 5 V and 500 μA pulses, 1 M load resistance.  
Rise time (10 % / 90 %) = 120 μs. 

 

Result of Example 3: With a higher load resistance, the current pulse shows a different kinetic behavior: 
The rise time increases significantly (about 100 μs). Please keep in mind that the resistance of the 
oscilloscope probe with 10 M is parallel to the 1 M load resistance. That means, that the maximum  
of the load resistance is reduced to 900 k only. 
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11.6 Comparison of Output Signals in Current Mode 

To show the different behavior of the output signals in current mode, there are some examples to get  
an idea how the stimulus generator will deliver the stimulus pulses. The screen shots are from a standard 
oscilloscope triggered on the Sync Out pulse (see "Measuring output signals with an oscilloscope").  

 

Example 1: Influence of the length of a current pulse 100 μs versus 20 μs with an amplitude of 1600 μA, 
which is at the maximum capacity of the STG4000 series (constant amplitude and load resistance). 

Example 1a: Current pulse with programmed 1600 μA for 100 μs and 20 μs interval and 10 k load 
resistance. 

The pulse is biphasic, and 1600 μA which is the limit of the maximum capacity of the STG 4000 series. 
Green trace = current output (+I), pink trace = TTL trigger output from the Sync Out. 
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Example 1b: Current pulse with programmed 1600 μA for 20 μs and 20 μs interval and 10 k load 
resistance. 

The pulse is biphasic, and 1600 μA which is the limit of the maximum capacity of the STG 4000 series. 
Green trace = current output (+I), pink trace = TTL trigger output from the Sync Out. 

 

Result of Example 1: The current output signal is delivered unmodified without any influence  
of the length of the pulse with an amplitude of 1600 μA which is at the maximum capacity of  
the STG 4000 series. 

 



Analog Output Signals 

87 

Example 2: Influence of the length of a current pulse 100 μs versus 20 μs with an amplitude of 16 μA 
which is a hundredth of the limit of the maximum capacity of the STG 4000 series (constant amplitude  
and load resistance). 

Example 2a: Current pulse with programmed 16 μA for 100 μs and 20 μs interval and 10 k load 
resistance. 

The pulse is biphasic 16 μA  Green trace = current output (+I), pink trace = TTL trigger output from  
the Sync Out. 
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Example 2b: Current pulse with programmed 16 μA for 20 μs and 20 μs interval and 10 k load 
resistance. 

The pulse is biphasic 16 μA. Green trace = current output (+I), pink trace = TTL trigger output from  
the Sync Out. 

 

Result of Example 2: The current output signal is delivered unmodified without any influence  
of the length of the pulse, and an amplitude of 16 μA which is a hundredth of the limit of the  
maximum capacity of the STG 4000 series. 
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Example 3: Influence of the length of a current pulse and a high load resistance. Current pulse with 
programmed 16 μA for 100 μs and 20 μs interval and 1 M load resistance. The load resistance is very 
high. Please keep in mind that the load resistance of 1 Mis parallel toMof the probe of the 
oscilloscope. That means, the load resistance is reduced to 900 konly 

The pulse is biphasic, and 16 μA which is a hundredth of the limit of the maximum capacity of the 
STG4000 series. Green trace = current output (+I), pink trace = TTL trigger output from the Sync Out. 

 

Result of Example 3: The current output signal is delivered strongly modified because of the high load 
resistance of 1 M, and the duration of the pulse, 100 μs and the interval. Before the pulse is reaching  
its maximum, it has to turn into its invert phase. Before the pulse is reaching its minimum, it is cut off. 
Please see example 4: If the duration of pulse and interval is much longer, 1 ms, the pulse shape of the 
delivered signal is much better. 
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Example 4:  Influence of the length of a current pulse and a high load resistance. Current pulse with 
programmed 50 μA for 1 ms and 1 ms interval and 1 M load resistance. The load resistance is very high, 
the duration of the pulse and the interval are long. Please keep in mind that the load resistance of 1 M
is parallel toMof the probe of the oscilloscope. That means, the load resistance is reduced to  
900 only 

The long pulse is biphasic, 50 μA. Green trace = current output (+I), pink trace = TTL trigger output from 
the Sync Out. 

 

Result of Example 4: The current output signal is delivered negligible modified when the duration  
of the signal and the duration of the interval is long, for example 1 ms.  

 

 



Analog Output Signals 

91 

11.7 Capacitive Behavior of Stimulation Electrodes 

Regarding the generally used stimulus pulses, stimulating electrodes behave as plate capacitors. They need 
some time to discharge themselves after stimulation. As a result, artifacts interfere with the recording, and 
electrodes deteriorate over time due to electrolysis. This effect takes place especially in current mode 
because the current cannot flow back to the stimulus generator due to the high output resistance in 
current mode and thus is kept in the electrode. A current source can constantly produce small currents, 
even though the current is set to zero. This might damage the connected electrodes over time. To avoid this 
problem, the STG4000 series is equipped with switches that automatically disconnect the current outputs 
from the current source 1 s after each programmed current stimulus. For the next stimulus, the current 
source is automatically reconnected.    

To reduce the effect described above in current mode, you should use biphasic pulses for stimulation. 
The stimulus signal should be immediately followed by an inverse signal of the same area (product of 
current and time), which helps to discharge the electrode. The easiest way is to use the same signal 
amplitude with an opposite polarity. 

Multi Channel Systems recommends using voltage driven stimulation. In voltage mode, it is not necessary 
to use biphasic stimulation for discharging the electrodes, because the electrode should be discharged at  
a voltage of 0, that is, it would be sufficient to apply the negative phase only. 

 

Warning: When using MEA electrodes of TiN material, stimulation with higher amplitudes is possible  
if you apply the negative pulse first. Also, regard the safe charge-injection limit as described in the 
MEA manual. Otherwise, electrodes can be damaged during stimulation. 

The following illustration shows the effect of a biphasic current pulse on the discharge of the stimulation 
electrode. As you can see, the first monophasic pulse is followed immediately by a pulse of the opposite 
polarity and the same product of current and time. 

Effect of a bipolar current pulse on the electrode voltage 
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12 Troubleshooting 

12.1 About Troubleshooting 

Most problems occur seldom and only under specific circumstances. In most cases, it is only a minor 
problem that can be easily avoided or solved. 

If the problem persists, please contact your local retailer. The highly qualified staff will be glad to help you. 
Please inform your local retailer as well, if other problems that are not mentioned in this documentation 
occur, even if you have solved the problem on your own. This helps other users, and it helps MCS to 
optimize the instrument and the documentation. 

Please pay attention to the safety and service information (chapter "Important Safety advice" in the  
Manual / Help). Multi Channel Systems MCS GmbH has put all effort into making the product fully stable 
and reliable, but like all high-performance products, it has to be handled with care. 

12.2 Technical Support 

Contact your local retailer immediately if the cause of trouble remains unclear. Please understand that 
information on your hardware and software configuration is necessary to analyze and finally solve the 
problem you encounter. 

If you have any questions or if any problem occurs that is not mentioned in this document, please contact 
your local retailer. The highly qualified staff will be glad to help you. 

Please keep information on the following at hand 

 Description of the error (the error message text or any other useful information) and of the context  
in which the error occurred. Try to remember all steps you had performed immediately before the error 
occurred. The more information on the actual situation you can provide, the easier it is to track the 
problem. 

 The serial number of the device. You will find it on the device or click on the Help menu, click About. 

 The software (SW) and hardware (HW) version you are currently using. On the Help menu, click 
About. The displayed dialog box shows the version numbers. 

 The operating system and service pack number on the connected computer. 

 The hardware configuration (microprocessor, frequency, main memory, hard disk) of the connected 
computer. This information is especially important if you have modified the computer or installed new 
hard- or software recently. 
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12.3 Error Messages 

This chapter explains error messages to you that may occur during normal operation. They do not present  
a reason to worry and can be easily avoided. 

General operation 

 

is displayed when you try to close a file in Multi-File mode. You cannot close files if you are in Multi-File 
mode (indicated on the MC_Stimulus status bar). Please leave the Multi-File mode by selecting Standard 
under Mode in the Trigger Settings dialog box before closing files. 

Download 

These error messages may occur during download on the STG. Please note that you can switch off some  
of these messages if they disturb your experiment. See chapter "Downloading Stimuli" for more details  
on downloading. 

 

The worksheet is empty. No data is present that 
can be downloaded. Please create a stimulus or 
open a stimulus file before downloading.  
In Multi-File mode, the corresponding file will  
be completely ignored. 

 

There is no stimulus generator connected to the 
computer or the STG may be switched off. Please 
check the computer connection and the status 
lamp of the STG. 

 

There is no valid connection to an STG. Download  
of data is not possible. Please check the computer 
connection and the status lamp of the STG. 

 

The last voltage / current values of the named 
channels are not zero. The current / voltage levels 
are set to zero after the last value. The last used 
values of these channels are kept until the STG  
is stopped. 
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ASCII Import 

These error messages relate to a wrong file format. Please see chapter "Supported File Format" for more 
information. 

 

The named line contains  
an unexpected character. 

 
 

The channel number specification 
has to precede the data. The 
channel number either lacks or the 
specified number does not exist (for 
example, number 13). 

 

Each data column must have  
a header (value, time, or repeat). 

 
 

The number of data columns has to 
be consistent for all lines in a given 
ASCII file (for example, value, time, 
value, time). This error message 
indicates that there is a current / 
voltage value or a time point 
missing in line 12. 

 

The ASCII file contains current / 
voltage values outside the STG's 
range. For example, if the STG's 
output range is +8000 mV, all 
values above +8000 mV are set  
to +8000 mV. 
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12.4 Signal terminated when using Trigger In 

If you use the Trigger In to start the STG and the stimulation protocol is terminated right after start, check 
the Trigger Settings. If the Use Trigger as Gate function is selected, a protocol will only be active as long 
as the Trigger is HIGH. If the Single Trigger function is selected, the STG is armed and waits for an external 
trigger to execute the stimulus protocol one time only. Switch to Stop, Restart or Ignore. 

 

12.5 Strong Peak Artifacts 

Strong discharges or other artefacts of the output voltage or current. 

Possible causes: 

? One or both current outputs are open, that is, nothing is connected to them. The stimulus generator tries 
to hold a stable current against the indefinite resistance of the open current output. Therefore, the stimulus 
generator will increase the output voltage on the open current outputs to its maximum, which will result in 
a heavy load on the power supply. This situation may cause the power supply to become unstable, which 
may lead to artifacts on all channels. 

 In current mode: Connect the unused current output to ground (GND). Please see also the 
recommended setups in the chapter “Current Mode”. 

 

12.6 Output Signal does not Match Programmed Signal 

The amplitude or the duration of the output pulses differs from the programmed signal. 

Possible causes: 

? The stimulus protocol works near the resolution limits of the STG, that is, the pulses are very short or the 
amplitudes very low (smaller than 50 mV or 10 μA). 

 Check the output signals with an oscilloscope and modify the pulse protocol so that the amplitude and 
timing of the pulses will match your requirements. 

? You operate the STG in current mode, and the electrode resistance of the stimulating electrodes  
is too high. According to Ohm's law, the electrode resistance directly affects the kinetics of the current 
output. The rise time increases with an increasing electrode resistance. If the electrode resistance is too  
high for the compliance voltage, the output signal will be clipped. 

 Try to stimulate in voltage mode. 

 Try to use stimulating electrodes with a lower impedance. 

 Check the output signals with an oscilloscope and modify the pulse protocol so that the amplitude and 
timing of the pulses will match your requirements. 
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12.7 Signal is not Repeated / Pulse Train Fails 

The STG fails to generate a train of pulses. When a pulse is programmed in MC_Stimulus and then 
repeated (in the Trigger Settings dialog box) (with the Repeat option), the STG abruptly stops after it has 
generated the waveform only once. (If another STG is connected to the computer to run the same protocol, 
the stimulator has no problems on repeating the pulse.) 

Possible causes: 

? If you change the stimulus protocol after the download, even if only the number of repeats were changed, 
you need to download the modified stimulus protocol to the STG. Otherwise, the changes will not be 
applied. (If another STG is connected to the computer, you will have to download the stimulus protocol, 
including the changes, to be able to stimulate at all.) 

 Select Download or Download and Start on the STG menu (or on the toolbar) after you made any 
changes to the stimulus protocol in the MC_Stimulus program. 

 

12.8 Internal Calibration Signals 

The STG emits sometimes autonomous high frequency signals. 

Cause: 

During the first ten minutes after starting the STG, the device emits every minute high frequency signals 
(small bursts) for internal offset calibration of the current outputs in a range of +/- 10 mV. After warming 
up the STG, the calibration signals later will be delivered half-hourly. 

The calibration is interrupted during stimulation. 

High sensitive measuring equipments will monitor these calibration signals. 

Biological signals are usually slower than the high frequency bursts and will not interfere with the 
calibration signals. 

When monitoring the experimental signals with MC_Rack software, you do not see the calibration signals, 
because MC_Rack automatically applies a 3 kHz low pass filter during data acquisition, and a 10 kHz low 
pass filter during filter activities.   

When using MC_Stimulus II Version 3.3 and higher it is possible to avoid the internal offset calibration. 
Enable the command “Disable Autocalibration” in main menu “STG” and download the command to the 
STG.  
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13 Appendix 

13.1 Technical Specifications STG4004 and STG4008 

Operating temperature 10 °C to 50 °C 

Storage temperature    0 °C to 70 °C  

Dimensions (W x D x H) 325 x 310 x 85 mm 

Weight 2.8 kg 

Fuse internal, 3.15 A slow 

Supply voltage (external power supply) 100 - 240 VAC @ 47 to 63 Hz 

Number of analog output channels 4 (STG4004) or 8 (STG4008) 

 

Output voltage -8 V to +8 V @ max. ± 20 mA 

Output voltage resolution 1 mV 

Rise time (10-90 %) voltage 1.7 μs @ delta U = 8 V    

Time lag between Sync Out and voltage 
output 

15 (± 2) μs @ amplitude > 200 mV 

 

Output current Standard: -1.6 mA to +1.6 mA @ max.120 V compliance 
voltage (between +I and -I) 

Or: -16 mA to +16 mA @ max.120 V compliance voltage 
(between +I and -I) 

Or: -160 μA to +160 μA @ max.120 V compliance voltage 
(between +I and -I) 

Output current resolution Standard: 200 nA (with ± 1.6 mA) 

Or: 2000 nA (with ± 16 mA) 

Or: 20 nA (with ± 160 μA) 

Output current slope  600 μA/μs @ RL =  10 k 

Rise time (10-90 %) current,  
0 - 100 μA 

1.4 μs @ RL =  10 k 

Time lag between Sync Out and current 
output, 0 - 100 μA 

15 ( ± 2) μs  @ RL =  10 k  if continuous mode is enabled 

50 ( ± 2) μs  @ RL =  10 k  if continuous mode is disabled 

 

Resolution  14 bit 

Time resolution 20 μs 

Output signals Freely programmable (rectangular, ramp, sinusoidal) 

Maximum frequency (rectangular 
waveform) 

25 kHz 

Memory capacity for stored waveforms 64 MB 

 

Timing on external trigger 

Minimum time length of trigger input (TTL) 40 μs 

Time lag between trigger input and Sync Out 70 (± 10) μs 

Maximum trigger input frequency 10 kHz 
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Interface and connectors 

Sync Out for synchronization with following devices 4 / 8 digital channels via coax cable 

Trigger In for synchronization with preceding devices 4 / 8 digital channels via coax cable 

Interface (connection to computer) USB 2.0 High Speed 

Download rate max. 480 Mb per second 

 

Software  

MC_Stimulus II Version 3.4.4 and higher 

Operating system Microsoft Windows ® 10, 8 and 7 (32 or 64 Bit),  
Vista or XP with NTFS; English and German versions supported 

Data import / export ASCII file format 

 

Note: Other configurations of output currents are available on request. Please contact MCS. 

 

13.2 Pin Layout Digital I / O 

Pin layout of the DIGITAL IN / OUT connector. 

Available with STG4004 and STG4008. 

 

25-Pin Female D-Sub Connector 

 

Pin   1 -  8 Digital input D0 - D7 for “Extended Multi-File Mode”  

Pin   9 - 16 Digital output D8 - D15 (not connected) 

Pin  17 - 25 GND (ground) 
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13.3 Contact Information 

Local retailer 

Please see the list of official MCS distributors on the MCS web site. 

User forum 

The Multi Channel Systems User Forum provides the opportunity for you to exchange your experience  
or thoughts with other users worldwide. 

Mailing list 

If you have subscribed to the newsletter you will be automatically informed about new software releases, 
upcoming events, and other news on the product line. You can subscribe to the list on the contact form  
of the MCS web site. 

www.multichannelsystems.com 





 

103 

14 Index 



Stimulus Generator 4000 Series Manual 

104 



 

105 

A 
About dialog 53 

Adjusting 
Stimulus Intensity Level ........................ 32 

Amplifier 
blanking .............................................. 57 
connecting .................................... 70, 74 

Amplitude 
adjusting stimulus intensity level .......... 32 
effects on rise time .............................. 77 
of sine wave ........................................ 20 

Analog 
current output ..................................... 74 
input ..................................................... 8 
voltage output ..................................... 70 

Arrange Icons 53 

ASCII 
Import without Header ........................ 36 
importing ASCII files ............................ 35 
supported file format ........................... 36 

Assign 
channels to Auto Sync ......................... 31 
files to trigger ...................................... 63 
trigger inputs to multiple files .............. 63 
trigger to channels ............................... 60 
trigger to Sync Outs ............................. 60 

Auto Download 
stimulus intensity level ......................... 32 

Autocalibration 11 
disable ................................................. 11 

Autocreating 
stimuli ................................................. 25 

Autofill 25 

Autorepeat 
pulses or complete pulse protocols ...... 22 

B 
Back panel 8 

Batch 
menu ................................................... 53 
mode ................................................... 67 

Batch Mode 67 

Biphasic pulse 20, 91 

Blanking 
amplifier .............................................. 57 
autocreating blanking pulses ............... 31 
signal ................................................... 57 

BNC 
connection to oscilloscope ................... 77 
connectors ............................................. 8 

C 
Cables 

shielding ........................................ 70, 74 
twisted pair ......................................... 70 

Capacitive 
behavior of electrodes ......................... 91 

Cascade 53 

Change All 
stimulus intensity level ......................... 32 

Change Time Unit 25 

Channels 
connecting ............................................ 8 
displaying ............................................ 45 
downloading ....................................... 49 
editing ................................................ 19 

Clear 
file assignment in Multi File mode ....... 63 

Compiler warnings 56 

Connecting 
the STG to an amplifier ......................... 8 
the STG to an oscilloscope .................. 77 

Contact 
information ....................................... 101 

Continuous 
stimulation .......................................... 22 

Copy 
row ..................................................... 54 
shortcut key ........................................ 54 

Count 25 

Creating 
Autosync pulses .................................. 31 
Stimuli ................................................. 19 

Current 
capacitive behavior of electrodes ......... 91 
electrode impedance ........................... 77 
maximum output current .............. 74, 99 
measuring output with an oscilloscope 77 
oscilloscope ......................................... 74 
output mode ........................... 19, 69, 74 
resolution ............................................ 20 

Cursor 45 

Cut 
rows .................................................... 54 
shortcut key ........................................ 54 

D 
Data 

ASCII file format .................................. 36 
download ............................................ 49 
save..................................................... 55 

Digital 
blanking signal .................................... 57 
input ............................................... 8, 58 
output ............................................. 8, 57 
port ....................................................... 8 

Display 
Auto Sync output ................................ 31 
scrolling .............................................. 45 
selecting channels ............................... 45 



Stimulus Generator 4000 Series Manual 

106 

settings ................................................ 45 
zooming .............................................. 45 

Downloading 
batch mode ......................................... 67 
shortcut key ......................................... 54 
stimulus files ........................................ 49 

Driver 
installation ............................................. 9 

Duration 
pulse ................................................... 20 

E 
Edit 

Auto Sync Settings ............................... 31 
menu ................................................... 53 
Multi File mode .................................... 63 
Trigger Settings ................................... 60 

Electrode 
capacitive behavior .............................. 91 

End 
point of ramp ...................................... 20 
run ...................................................... 11 

Error Messages 94 

Extended Multi File Mode 64 

F 
Faraday cage 

connecting .................................... 70, 74 

File 
Batch mode ......................................... 67 
importing ASCII files ............................ 35 
menu ................................................... 53 
Multi File mode .................................... 63 
new ..................................................... 54 
open .................................................... 54 
save ..................................................... 54 

Format 
ASCII file .............................................. 36 
time axis .............................................. 45 

G 
GND outputs 

about .................................................. 69 
connecting .................................... 70, 74 

Ground 
connecting .................................... 70, 74 
input ..................................................... 8 
outputs ................................................ 69 

Group 
Group Repeat ...................................... 22 
Group/Ungroup ................................... 22 

H 
Header 

of ASCII file .......................................... 36 

Help 
menu ................................................... 53 

I 
I outputs 

about ............................................ 69, 74 
measuring with an oscilloscope ........... 77 

Icons 
arrange ............................................... 53 

Ignore 
files on trigger ..................................... 63 
trigger events if channels still active ..... 60 

Importing 
ASCII files ............................................ 35 
supported ASCII file format ................. 36 

Incrementing 
values in a column ............................... 25 

Input 
analog ................................................... 8 
MC_Card ............................................... 8 
MEA1060 .............................................. 8 
trigger (Multi File mode) ...................... 63 
trigger settings .................................... 60 
TTL ...................................................... 58 

Installing 
Software ............................................. 10 
STG driver ............................................. 9 

Inverting 
pulses .................................................. 25 
selection .............................................. 25 

K 
Keep Zero 25 

L 
Length 

of pulse ............................................... 20 

Load resistance 
effects on rise time .............................. 77 

Loading 
ASCII files ............................................ 35 
files in Batch mode .............................. 67 

M 
MC_Card 

connecting ............................................ 8 

MEA1060 
connecting ............................................ 8 

Measure tool 45 

Message boxes 
warning messages ............................... 56 

Monophasic pulse 91 

Multi-File mode 63 

Multiple STGs 
controlling ........................................... 11 
Operating ............................................ 14 

N 
New File 54 



Index 

107 

O 
Open 

ASCII files ............................................ 35 
file ....................................................... 54 
files in Multi File mode ......................... 63 
shortcut key ......................................... 54 
stimulus files ........................................ 55 

Oscilloscope 
comparing STG current signals ............ 85 
measuring current signals .................... 74 
measuring STG output with an oscilloscope
 ............................................................ 77 
measuring STG signals ......................... 70 

Output 
analog output signals .......................... 69 
autocreating Sync Out pulses ............... 31 
doubling amplitude ............................. 70 
measuring with an oscilloscope ........... 77 
mode ................................................... 19 
signal inversion .............................. 70, 74 
Sync Out settings ................................. 60 

P 
Panel 

rear panel .............................................. 8 

Paste 
rows .................................................... 54 
shortcut key ......................................... 54 

Period 
of sine wave ........................................ 20 

Port 
digital .................................................... 8 
serial ...................................................... 8 
USB ....................................................... 8 

Post Time 31 

Pre Time 31 

Print 
preview ............................................... 55 
printing worksheet .............................. 55 
setup ................................................... 55 
shortcut key ......................................... 54 

Pulse 
Autocreating Sync Out pulses .............. 31 
duration .............................................. 20 
length .................................................. 20 
types ................................................... 20 

R 
Ramp 

pulse type ............................................ 20 

Rear panel 8 

Rectangular 
pulse type ............................................ 20 

Repeating 
a group of rows ................................... 22 
continuously ........................................ 22 
on a trigger ......................................... 22 

pulses .................................................. 22 
rows .................................................... 22 

Requirements 
system ................................................. 10 

Reset 
display ................................................. 45 
STG ..................................................... 53 

Reset All 
stimulus intensity level ......................... 32 

Resolution 
current ................................................ 20 
time .................................................... 20 
voltage ................................................ 20 

Restart 
channels on a trigger ........................... 60 
files on trigger ..................................... 63 

Rise Time 77 

Rising edge 
of TTL signal ........................................ 58 
time offset (Auto Sync) ........................ 31 

Row Repeat 22 

Run 
STG ..................................................... 11 

S 
Save 

file....................................................... 54 
shortcut key ........................................ 54 
stimulus files ....................................... 55 
trigger settings .................................... 60 

Scrolling 45 

Select Device 11 
change ................................................ 11 
multiple ............................................... 11 

Serial port 8 

Settings 
Auto Sync ........................................... 31 
menu .................................................. 53 
Multi File mode ................................... 63 
Sync Out ............................................. 60 
trigger ................................................. 60 

shielding 
cables ............................................ 70, 74 

Shifting 
values .................................................. 25 

Show 
Auto Sync output ................................ 31 
measure tool ....................................... 45 

Signal 
blanking .............................................. 57 
current mode ...................................... 74 
measuring output signals with an 
oscilloscope ......................................... 77 
menu .................................................. 53 
Sync Out ............................................. 57 
voltage mode ...................................... 70 



Stimulus Generator 4000 Series Manual 

108 

Sine wave 
pulse type ............................................ 20 

Single Trigger 60 

Size to fit 45 

Software 
installation ........................................... 10 
requirements ....................................... 10 

Start 
channels on trigger .............................. 60 
files on trigger ..................................... 63 
shortcut key ......................................... 54 
STG ..................................................... 11 

Starting 
point of ramp ...................................... 20 

STG 
connecting ............................................ 8 
installing ................................................ 9 
menu ................................................... 53 
starting .......................................... 11, 58 

Stimuli 
creating ............................................... 19 

Stimulus Files 
ASCII Import without Header ............... 36 
downloading ....................................... 49 
triggering multiple files ........................ 63 

Stimulus Intensity Level 
Adjusting ............................................. 32 

Stop 
Batch menu ......................................... 67 
channels on a trigger ........................... 60 
files on trigger ..................................... 63 
shortcut key ......................................... 54 
STG ..................................................... 54 
stopping STG ....................................... 11 

Support 93 

Sweep 
LED Start/Stop buttons......................... 11 
starting STG on trigger ........................ 11 
status lamp .......................................... 58 
sweep count ........................................ 60 
triggering ............................................ 60 
triggering sweeps ................................ 58 

Switch 
circuit diagram ..................................... 58 

Sync Out 
autocreating Sync Out pulses ............... 31 
connectors ............................................. 8 
digital TTL outputs ............................... 57 
settings ................................................ 60 

System requirements 10 

T 
Tile 53 

Time 
axis format .......................................... 45 
change time units ................................ 25 

resolution ............................................ 20 
rise time .............................................. 77 
time offset for Auto Sync .................... 31 

Timing 
blanking of amplifier ........................... 57 
rise time .............................................. 77 

Toolbar 
position ............................................... 53 

Trigger 
blanking signal .................................... 57 
connectors ............................................ 8 
continuous mode .......................... 22, 60 
files ..................................................... 63 
gate .............................................. 22, 60 
gating trigger ................................ 22, 60 
input ................................................... 58 
LED Start/Stop Button .......................... 11 
manual ................................................ 11 
output ................................................. 57 
repeating pulses .................................. 22 
separate .............................................. 11 
settings ............................................... 60 
single trigger ....................................... 60 
STG ............................................... 11, 58 
triggering multiple files on different 
triggers (Multi File mode) .................... 63 
triggering multiple files on same trigger 
(Batch mode) ....................................... 67 

Troubleshooting 93 

TTL 
autocreating Sync Out pulses .............. 31 
blanking signal .................................... 57 
digital output ...................................... 57 
Sync Out settings ................................ 60 
trigger settings .................................... 60 
triggering ............................................ 58 
triggering in Multi File mode ............... 63 

twisted pair cables 70 

U 
U outputs 

about ............................................ 69, 70 
measuring with an oscilloscope ........... 77 
oscilloscope ......................................... 70 
voltage mode ...................................... 70 

Undo 
shortcut key ........................................ 54 

Update 
software .............................................. 10 

USB connector 8 

USB-MEA32-STIM4-System 14 
Select Stimulation Channels ................ 14 

V 
View 

menu .................................................. 53 

Voltage 
maximum output .......................... 70, 99 



Index 

109 

measuring output with an oscilloscope 77 
output mode ........................... 19, 69, 70 
resolution ............................................ 20 

W 
Warning messages 

disabling .............................................. 49 

Window 
menu .................................................. 53 
WYSIWYG window ............................. 45 

Z 
Zooming 45 



 

110 

 


